The section provides a general outline of operational procedures.

## Loading Batteries (page E-38)

### Setting the Current Date and Time (page E-44)

1. **Slide the battery compartment cover lock towards the front of the camera** (①) to release the cover.
2. **Grasping both sides of the battery compartment cover,** swing it open (② ③).
3. **Load batteries so their plus (+) and minus (–) ends are facing as shown in the illustration.**

   - **Close the battery compartment cover** (① ②), and then slide the battery compartment cover lock towards the back of the camera to lock the cover in place (③).

   - **Be sure to use the procedure on page E-44 to set the time and date before using the camera for the first time.**
   - **File name assignment and time stamping will not be performed correctly if the time and date are wrong.**
Slide the Function Switch to REC.

2

Set the dial to "" for normal recording.

3

After composing the image on the monitor screen, press the shutter button about half way and hold it there.
* The camera’s Auto Focus feature automatically focuses the image.

4

After confirming that the Auto Focus operation is complete (the operation lamp lights green), press the shutter button all the way down to record the image.

5

After confirming that the Auto Focus operation is complete (the operation lamp lights green), press the shutter button all the way down to record the image.
3. Use [+] and [-] to scroll through the images stored in camera memory.

2. Slide the POWER Switch in the direction indicated by arrow. • The image you recorded appears on the monitor screen.

1. Slide the Function Switch to PLAY.
Slide the Function Switch to PLAY.

Press MENU.

Use [+] and [–] to select “Delete”, and then press the shutter button.

Use [+] and [–] to select “Select”, and then press the shutter button.

Use [+] and [–] to select an image you want to delete and then press the shutter button. Selected images are indicated by 📚.

• Note that the first time you display an image its 📚 icon is turned on.

Double check to make sure that you really want to delete the image you selected.
* Press MENU to exit the image delete operation.

Press DISP.

Use [+] and [–] to select “Yes”, and then press the shutter button.
INTRODUCTION
Congratulations upon your selection of the QV-8000SX LCD Digital Camera.
To get the most out of the QV-8000SX, be sure to carefully read this manual and follow the instructions contained in it.
Landscape Mode Recording .................................... E-66
Monochrome and Sepia Recording ......................... E-66
Portrait Recording .................................................... E-67
Using the Self-timer ................................................. E-68
Using the Timer ....................................................... E-69
Shutter Speed Priority Image Recording ................. E-70
Aperture Priority Image Recording ......................... E-71
Performing Manual White Balance ....................... E-72
Recording Made Power On Settings ....................... E-73
Using the Record Menus ......................................... E-75

PLAYBACK
Basic Playback Operation ....................................... E-79
Playing Back a Movie .............................................. E-80
Panorama Playback ................................................ E-81
Using Zoom ............................................................. E-82
Displaying Nine Images ........................................... E-83
Slide Show ............................................................... E-84
Screen Saver ........................................................... E-85
Using the Playback Menus ....................................... E-86

FOLDER TYPES
Memory Card Folder Precautions ......................... E-88
Selecting a Folder for Playback ......................... E-89

IMAGE PROTECTION
Protecting and Unprotecting a Single Image .......... E-90
Protecting and Unprotecting Folders ................. E-91
Protecting and Unprotecting
All Images on a Memory Card ......................... E-91

DELETING IMAGES
Deleting a Single Image ........................................ E-92
Deleting All the Images in a Folder ................... E-93
Deleting All Unprotected Images .................... E-94

DPOF
Printing Specific Images ..................................... E-95
Printing All the Images in a Folder .................. E-96
Printing All Images .............................................. E-97

CONNECTING TO OTHER EQUIPMENT
Connecting to a Television .................................... E-99
Connecting to a Computer .................................. E-100

USING CompactFlash CARDS WITH YOUR COMPUTER
Setting Up to Access CompactFlash Card
Contents From Your Computer ......................... E-103
Memory Card Data ................................................. E-104
Card Browser ....................................................... E-106

TROUBLESHOOTING
MESSAGES
SPECIFICATIONS
• CASIO COMPUTER CO., LTD. assumes no responsibility for any damage or loss resulting from the use of this manual.

• CASIO COMPUTER CO., LTD. assumes no responsibility for any loss or claims by third parties which may arise through the use of the QV-8000SX.

• CASIO COMPUTER CO., LTD. assumes no responsibility for any damage or loss caused by deletion of data as a result of malfunction, repairs, or battery replacement. Be sure to back up all important data on other media to protect against its loss.

• Windows and Internet Explorer are registered trademarks of Microsoft Corporation.

• Macintosh is a registered trademark of Apple Computer, Inc.

• COMPACTFLASH™ and logo are registered trademarks of SanDisk Corporation.

• Other company, product and service names used herein may also be trademarks or service marks of others.

• The USB driver uses software by Phoenix Technologies Ltd.

Compatibility Software Copyright © 1997 Phoenix Technologies Ltd., All Rights Reserved.
FEATURES

Continuous recording (page E-57)
Continuous recording of high-quality images at 0.25-second intervals is just like having a motor drive on the camera.

DCF Data Storage (page E-104)
DCF (Design rule for Camera File system) data storage protocol provides image inter-compatibility between the digital camera and printers.

Digital Print Order Format (DPOF) (page E-95)
Images can be easily printed in the sequence you want using a DPOF compatible printer. DPOF can also be used by professional print services when specifying images to produce prints.

Simple image management (page E-106)
Images are stored on a large-capacity CompactFlash memory card. A new Card Browser feature produces thumbnails of all images on a card quickly and easily.
Movie and panorama images (pages E-80, 81)
A buffer lets you capture images of events that occurred before you pressed the shutter button. A built-in function lets you combine up to nine images into breathtaking panoramas.

Easy-to-understand graphic interface (page E-32)
All camera operations can be performed on graphic based interactive menu screens. CASIO high-resolution HAST LCD makes screen images clearer and more colorful than ever before.

CASIO original metering system
Light metering includes innovative multi-pattern metering.

Megapixel CCD
Images are recorded by a 1.31-megapixel CCD for amazing resolution and clarity. Some slight image noise may be caused when using slow shutter speeds.

Easy connection to other devices (page E-99)
USB, DIGITAL, and VIDEO OUT terminals provide easy connection to other devices.

TV

Desktop Computer

Notebook Computer
32X zoom is produced using 8X optical zoom together with 4X digital zoom.

Macro Feature

Landscape Mode

Portrait Mode

Night Scene

Shutter Speed Priority
FEATURES

Display Zoom

Image Protection

Wired Remote Controller

page E-82

page E-90

page E-21
General Precautions

Be sure to observe the following important precautions whenever using the QV-8000SX.

All references in this manual to “this camera” and “the camera” refer to the CASIO QV-8000SX Digital Camera.

• Never try to take pictures or use the built-in display while operating a motor vehicle or while walking. Doing so creates the danger of serious accident.
• Never try to open the case of the camera or attempt your own repairs. High-voltage internal components create the risk of electrical shock when exposed. Always leave maintenance and repair work up to authorized CASIO service providers.
• Never fire the flash in the direction of a person operating a motor vehicle. Doing so can interfere with the driver’s vision and create the danger of accident.
• Never fire the flash while it is too close to the subject’s eyes. Intense light from the flash can cause eye damage if it is fired too close to the eyes, especially with young children. When using the flash, the camera should be at least one meter from the eyes of the subject.
• Keep the camera away from water and other liquids, and never let it get wet. Moisture creates the danger of fire and electrical shock. Never use the camera outdoors in the rain or snow, at the seashore or beach, in the bathroom, etc.
• Should foreign matter or water ever get into the camera, immediately turn power off, unplug the AC adaptor from the power outlet, and contact your dealer or nearest CASIO service provider. Using the camera under these conditions creates the danger of fire and electrical shock.
• Should you ever notice smoke or a strange odor coming out of the camera, immediately turn power off and unplug the AC adaptor from the power outlet. Using the camera under these conditions creates the danger of fire and electrical shock. After making sure there is no more smoke coming from the camera, take it to your nearest CASIO service provider for repair. Never attempt your own maintenance.
• At least once a year, unplug the AC adaptor from the power outlet and clean the area around the prongs of the plug. Dust build up around the prongs can create the danger of fire.
• If the camera’s case should ever become cracked due to dropping it or otherwise subjecting it to rough treatment, immediately turn power off, unplug the AC adaptor from the power outlet, and contact your nearest CASIO service provider.
• Never use the camera inside of an air craft or in any other areas where its use is prohibited. Doing so can result in an accident.
• Physical damage and malfunction of this camera can cause the image data stored in its memory to be deleted. Be sure to always keep backup copies of data by transferring them to personal computer memory.
Operating conditions

• This camera is designed for use in temperatures ranging from 0°C to 40°C.

• Do not use or keep the camera in the following areas.
  — In areas subject to direct sunlight
  — In areas subject to high humidity or dust
  — Near air conditioners, heaters, or other areas subject to temperature extremes
  — Inside of a closed vehicle, especially one parked in the sun
  — In areas subject to strong vibration

Condensation

• When you bring the camera indoors on a cold day or otherwise expose it to a sudden change of temperature, there is the possibility that condensation can form on the exterior or on interior components. Condensation can cause malfunction of the camera, so you should avoid exposing it to conditions that might cause condensation.

• To keep condensation from forming, place the camera into a plastic bag before moving it into a location that is much warmer or colder than your current location. Leave it in the plastic bag until the air inside the bag has a chance to reach the same temperature as the new location. If condensation does form, remove the batteries from the camera and leave the battery compartment cover open for a few hours.

• Never open the battery compartment cover, disconnect the AC adaptor from the camera or unplug it from the wall socket while recording images. Doing so will not only make storage of the current image impossible, it can also corrupt other image data already stored in camera memory.

• When you bring the camera indoors on a cold day or otherwise expose it to a sudden change of temperature, there is the possibility that condensation can form on the exterior or on interior components. Condensation can cause malfunction of the camera, so you should avoid exposing it to conditions that might cause condensation.

• To keep condensation from forming, place the camera into a plastic bag before moving it into a location that is much warmer or colder than your current location. Leave it in the plastic bag until the air inside the bag has a chance to reach the same temperature as the new location. If condensation does form, remove the batteries from the camera and leave the battery compartment cover open for a few hours.
About the camera’s backlight…

- The camera is equipped with a fluorescent light source to provide the back lighting for its LCD.
- The normal service life of the backlight is approximately six years, when the camera is used for about two hours a day.
- Should the LCD image appear abnormally dark, take the camera to your dealer or an authorized CASIO service provider to have the light source replaced. Note that you will be charged for this replacement.
- Under very cold conditions, the backlight may require more time than normal to light, or reddish bands may appear in the displayed image. These conditions do not indicate malfunction, and normal operation should return at higher temperatures.

Monitor Screen

Recording

- The image shown on the monitor screen during recording is intended for composition purposes only, so its quality does not match that of the image as it is recorded. The image is recorded in accordance with the quality setting made with the procedure under “Quality Settings” on page E-53.
- A dimly lit subject can slow down monitor screen refresh or cause static in the displayed image.

Playback

This camera is designed for high-speed scrolling of images during playback. Because of this, the playback image that initially appears on the monitor screen does not show the full resolution of the image as recorded. When you stop at the image you want, the monitor screen refreshes and shows the image in its full resolution.
**Lens**

- Camera performance can be adversely affected by fingerprints or dirt on the lens surface. Never touch the lens surface with your fingers.
- Should the lens become dirty, use a blower to blow off dirt and dust, or a soft, dry cloth to wipe off the lens.

**Date Setting**

No data setting is made before the camera is shipped from the factory. Be sure to use the procedure on page E-44 to set the time and date before using the camera for the first time. File name assignment and time stamping will not be performed correctly if the time and date are wrong.
UNPACKING

Check to make sure that all of the items shown below are included with your camera. If something is missing, contact your dealer as soon as possible.

- Camera
- Memory card (8 MB) Loaded in the camera when you purchase it.
- Wired Remote Controller
- Lithium Battery for wired remote controller (CR2025)
- Soft case
- Lens cap Attached to the lens.
- CD-ROM
- Alkaline batteries (AA-size x 4)
- 2-Way Shoulder/Wrist Strap
- Video cable
- Special USB cable
- Data Transfer Cable
- Manual • Basic Reference
- Bundled Software User’s Manual
**Using the Lens Cap**

Be sure to affix the lens cap whenever you are not using the camera. When affixing the lens cap, position it as shown in the illustration and press at the points indicated by the arrows.

- A clip on the back of the lens cap lets you fasten it to the camera strap.

**Attaching the Strap**

The two-way strap that comes with the camera can be used either as a shoulder strap or a wrist strap. Pass the wrist strap through the hole on the side of the camera as shown in the illustration.
**Using the Strap as a Wrist Strap**

Detach the upper strap from the main strap (Figure 1), and then attach the two buckles of the main strap to each other (Figure 2). Press the buckles together until they snap securely into place.

**Using the Strap as a Shoulder Strap**

Attach the strap to the camera so the shoulder pad is on the inside of the loop.

**IMPORTANT!**

- Be sure to keep the strap around your wrist whenever using the camera to protect against accidentally dropping it.
- The supplied strap is intended for use with this camera only. Do not use for any other application.
- Never swing the camera around by the strap.
- Allowing the camera to swing freely from your neck can result in damage to the camera due to its bumping against other objects. It also creates the danger of the camera becoming caught in a door or on other objects, resulting in personal injury.
Using the Soft Case

Keep the camera in its soft case to protect it when not in use.

Make sure the lens is facing up and the monitor screen is facing down.

The pocket inside the soft case can be used to store the wired remote controller and memory cards.

If you want to hang the camera from your shoulder while it is in the soft case, pass the shoulder strap through the hole in the side of the case.

Using the Wired Remote Controller

The wired remote controller that comes with the camera can be used to control the camera. When using a slow shutter speed or telephoto, you can avoid blurring of the image due to camera movement by mounting the camera on a tripod and using the wired remote controller to trigger the record operation. You can also use remote control for playback during presentations.

General Guide
Replacing the Wired Remote Controller Battery

The wired remote controller is powered by a single CR2025 lithium battery.

1. While pressing the battery holder lock, pull the battery holder from the wired remote controller.

2. After wiping off the two sides of a battery with a soft, dry cloth, place it into the battery holder with the positive (+) side facing up (so you can see it).

3. Slide the battery holder back into place.

Failure of the wired remote controller to operate probably means that the battery needs to be replaced.

Battery Precautions

- Keep batteries out of the reach of small children. If swallowed accidentally, contact a physician immediately.
- Misuse of a battery can cause it to leak, which damages and corrodes the area around the battery and creates the danger of fire and personal injury. Be sure to observe the following precautions.
- When loading the battery, make sure its positive (+) and negative (−) sides are facing correctly.
- Use only the battery type that is specified for this unit.
- Never try to charge a battery or take it apart, and never allow its poles to become connected to each other by metal (shorted). Do not expose batteries to heat or dispose of them by burning.
- Dead batteries tend to leak battery fluid. Never leave a dead battery in the wired remote controller.
Connecting to the Camera

Turn off camera power and then attach the plug of the wired remote controller to the camera’s DIGITAL terminal.

Wired Remote Controller Buttons

The buttons of the wired remote controller have the same basic functions as the buttons on the camera, except for the differences described below.

<table>
<thead>
<tr>
<th>To perform this operation:</th>
<th>Do this:</th>
</tr>
</thead>
</table>
| **Focus Lock**            | **Wired remote controller:** Press the FOCUS LOCK ON/OFF button to turn on focus lock, compose the image, and then press the SHUTTER button.  
  • Pressing FOCUS LOCK ON/OFF again cancels focus lock.  
  • Pressing the remote controller’s SHUTTER performs the focus operation, followed by recording of the image.  
  **Camera:** Press the shutter button half way, compose the image, and then press the shutter button (page E-49). |
| **Menu screen item selection** | **Wired remote controller:** Highlight the item on the camera’s monitor screen, and then press the SET button.  
  **Camera:** Highlight the item on the camera’s monitor screen, and then press the shutter button (page E-32). |
The following illustrations show the names of each component, button and switch on the camera.
Tripod screw hole

Battery compartment lock
(page E-38)

Battery compartment cover
(page E-38)

Opening the Terminal Panel Cover
Lens Filters

The area around the lens of the camera is threaded to allow use of commercially available lens filters with a diameter of 43mm. Simply screw the lens filter into place.

IMPORTANT!

- Certain types of filters can cause the problems described below. Be sure to carefully check any filter for these problems before purchasing it.
  * The frame around the outside of some filters may block light from the lens, resulting in shadows in the image.
  * Some filters can interfere with proper operation of Auto Focus and the flash unit.
  * Filter performance may not be equivalent to that obtained with a film-based camera.
- Do not use multiple filters with this camera.
- Do not use a lens hood. Doing so causes incorrect firing of the flash unit.
The following CASIO options can be used with this camera.

- TELE CONVERSION LENS LU-8T (×1.5)
- WIDE CONVERSION LENS LU-8W (×0.7)

### Operation Lamp

The operation lamp shows the operational status of the camera.

<table>
<thead>
<tr>
<th>Lamp Color</th>
<th>On</th>
<th>Flashing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Auto Focus operation complete</td>
<td>Please wait (after power on)</td>
</tr>
<tr>
<td></td>
<td>Monitor screen turned off due to sleep state activation or data communication</td>
<td>Image store operation in progress</td>
</tr>
<tr>
<td>Amber</td>
<td>Exposure warning</td>
<td>Flash is charging</td>
</tr>
<tr>
<td>Red</td>
<td>Cannot focus</td>
<td>Memory error</td>
</tr>
<tr>
<td></td>
<td>Memory full</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Cannot charge the flash</td>
<td></td>
</tr>
</tbody>
</table>
**Playback Mode**

<table>
<thead>
<tr>
<th>Lamp Color</th>
<th>On</th>
<th>Flashing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Monitor screen turned off due to data communication.</td>
<td>Please wait (after power on)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Delete operation in progress</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Format operation in progress</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Power off routine in progress</td>
</tr>
<tr>
<td>Red</td>
<td>—</td>
<td>Low battery</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Memory error</td>
</tr>
</tbody>
</table>

**Low Battery Warning**

Lights (red), after which camera power turns off automatically.
Pressing DISP causes various indicators to appear on the monitor screen.

**Recording Mode**

- **Focus mode indicator**
  - Auto Focus
  - Manual Focus
  - Macro
  - Infinity

- **Flash Mode**
  - Auto
  - Flash On
  - Flash Off
  - Red-eye reduction

- **Spot metering indicator**

- **Camera shake indicator**

- **Aperture value**

- **Battery capacity**

- **Shutter speed value**

- **EV shift**

- **Date and time**
  - This information appears for one or two seconds, and then disappears.

- **Recording Mode**
  - **Zoom factor**
    - X2, X4

- **Remaining number of pages**

- **Image size**
  - 1280 x 960
  - 640 x 480

- **Quality**
  - FINE
  - NORMAL
  - ECONOMY

- **Image information**
  - Movie Recording: recording time
  - ................ seconds
  - Panorama: number of images
  - ................ P1 to P9
  - Continuous Mode: mode indicator
  - Quick Shutter: buffer status
  - .......... ○○○○○
Screen when shutter is pressed half way

**Flash Mode ( فلاش) ( فلاش)**

- **Auto Focus Frame**
  - Focusing complete: Green
  - Focusing failed: Red

Flash indicator appears to indicate that flash will be fired (when auto flash is selected).

**Recording Mode Indicators**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>🕒</td>
<td>Timer</td>
</tr>
<tr>
<td>🌌</td>
<td>Night Scene</td>
</tr>
<tr>
<td>🌌</td>
<td>Panorama</td>
</tr>
<tr>
<td>🎥</td>
<td>Portrait</td>
</tr>
<tr>
<td>🎥</td>
<td>Landscape</td>
</tr>
<tr>
<td>🎥</td>
<td>Normal</td>
</tr>
</tbody>
</table>

Use the following procedure to switch the display language between English and Japanese.

1. **Press MENU.**
2. **Select “Set Up” → “Language”.**
3. **Select the display language you want.**
Menu Screens

Pressing MENU displays the menu screen. The contents of the menu screen depend on whether you are in the PLAY Mode or REC Mode. While the menu screen is on the display, press DISP to toggle between the basic menu and the advanced menu.

In this User’s Guide, the basic menu is always used for items that appear on both the basic menu and advanced menu. The basic menu displays settings required for basic functions, while the advanced menu includes settings for all functions.

- See “Using the Record Menus” on page E-75 and “Using the Playback Menus” on page E-86 for more information about menu contents.
Making menu settings

1. Slide the Function Switch to PLAY or REC.

2. Press MENU.

3. Press DISP to toggle between the basic menu and the advanced menu.

4. Use [+][-] to select the category or function you want, and then press the shutter button.

   - [+][-] : Item selection
   - Shutter Button : Execution of a selection
   - MENU : Returns to the previous screen or cancels settings.

   • Make settings in accordance with the guidance messages that appear on the monitor screen.

5. After making the settings you want, select “Exit” and then press the shutter button.
MEMORY CARDS

This camera uses a memory card (CompactFlash cards) for image memory. A memory card is loaded in the camera when you purchase it.

IMPORTANT!

- Make sure that the power of the camera is turned off before you insert or remove a memory card.
- When inserting a memory card into the camera, make sure that the card is oriented correctly. Make sure that the correct side of the card is facing up, and that you insert the correct end of the card into the camera.

Inserting a Memory Card into the Camera

1. Open the memory card slot cover.

2. As shown in the illustration, slide the memory card into the slot and push it in as far as it will go.
   - If the Eject button is extended, press it in before sliding the memory card into the slot.

3. Close the memory card slot cover.
Removing a Memory Card from the Camera

1. Open the memory card slot cover.

2. Press the eject button so it extends from the camera.

3. Press the eject button once again to eject the card.

4. Remove the memory card.

5. Close the memory card slot cover.

IMPORTANT!

- Insert only memory cards into the memory card slot. Inserting any other type of card can cause malfunction.
- Should water or any other foreign matter get into the memory card slot, immediately turn off power, unplug the AC adaptor, and contact your original retailer or nearest CASIO Service Provider.
- Never eject the CompactFlash card while the card slot is facing downwards. Doing so creates the danger of the CompactFlash card falling, which can corrupt image data on the card.
Formatting a Memory Card

You can format a memory card to delete all of the data stored on it.

**IMPORTANT!**
- Formatting a memory card deletes all images on the card, even if some or all of the images are protected (page E-90).
- Data deleted by a memory card format operation cannot be recovered! Be sure to carefully check and confirm that you no longer need the data stored in a memory card before formatting it.

1. Press MENU.
2. Select “Set Up” → “Format”.
3. In response to the confirmation message that appears, select “Yes” to start formatting the card.

Memory Card Precautions

- Images cannot be recorded with this camera unless a memory card is installed in it.
- Be sure to use only CASIO brand CompactFlash cards. Proper operation with other memory cards is not guaranteed.
- Static electricity, electrical noise, and other electrical phenomena can cause corruption or even total loss of the data stored on a memory card. Because of this, you should always make backup copies of important images on other media (magnetic optical disk, floppy diskette, computer hard disk, etc.).
- Memory card problems can be corrected by reformatting the memory card (page E-116). Reformatting a memory card deletes all images stored on the card, but you can use a computer to copy the images you want to keep to the computer’s hard disk before reformatting your card. If you plan to be recording images where you do not have access to a computer, it is a good idea to take along an extra memory card or two just in case you experience an unexpected memory card problem.
Memory Card Folder Precautions

- The camera automatically creates folders (directories) on the memory card and assigns them names based on dates (month and day). Any image you record is automatically stored into the folder that corresponds to the date it is recorded.
- Up to 900 folders can be created on a single card. The following shows a typical folder name.

- Formatting is recommended for any memory card that you suspect contains corrupted image data (due to a DECODE ERROR, strange image colors, malformed images) or newly purchased memory cards.
- Before starting a format operation, load a full set of new batteries (alkaline or lithium) into the camera or connect the AC adaptor to power the camera. Interruption of camera power during the format operation results in improper formatting, making it impossible to use the memory card.

- Up to 250 image files can be stored in each folder. The following shows a typical file name.

- When you try to save the 251st image to a folder, the camera automatically creates a new folder and store the image there.
- The above maximum number of files and folders are absolute maximums. The actual number of folders and files may be less due to memory card capacity and the size of each image.
- Panorama images are divided into multiple images and stored on the memory card.
- See “USING CompactFlash CARDS WITH YOUR COMPUTER” on page E-103 for information about how files and folders are organized.
The camera features a two-way power supply that lets you use either batteries (AA-size alkaline, lithium or Ni-MH) or household AC current.

### Loading Batteries

Be sure that camera power is turned off whenever loading or replacing batteries.

1. **On the bottom of the camera**, slide the battery compartment cover lock towards the front of the camera (1) to release the cover.

2. **Grasping both sides of the battery compartment cover**, swing it open (2 3).

3. **Load batteries so their plus (+) and minus (–) ends are facing as shown in the illustration.**

4. **Close the battery compartment cover (1 2), and then slide the battery compartment cover lock towards the back of the camera to lock the cover in place (3).**

Be sure to use alkaline, lithium or Ni-MH batteries. Never use manganese batteries (see precautions on the next page).

- Make sure the battery compartment cover is locked securely. Failure to do so can result in the cover opening, creating the danger of personal injury and corruption of image data.
Standard Battery Life

This camera can be powered using AA-size alkaline, lithium or Ni-MH batteries. The battery life reference values given below indicate the amount of time at standard temperature (25°C) until power automatically turns off due to battery failure. They do not guarantee that batteries will perform the amount of service indicated. Battery life is reduced by low temperatures and continued use.

- The above figures are approximations only.
- The above guidelines are based on the following battery types:
  - Alkaline: MX1500 (AA) DURACELL ULTRA
  - Lithium: Energizer
  - Ni-MH (Nickel-metal hydride): CASIO NP-H3
- Battery life varies with brand.
- Figures are based on continuous recording under the following conditions.
  - Flash turned off
  - One zoom slider switching between T (Telephoto) and W (Wide-angle)

Battery life is greatly affected by how much you use flash, zoom and other functions, and how long you leave power turned on.

<table>
<thead>
<tr>
<th>Type of Operation</th>
<th>AA-size Alkaline Batteries LR6</th>
<th>AA-size Lithium Batteries FR6</th>
<th>AA-size Ni-MH Batteries</th>
</tr>
</thead>
<tbody>
<tr>
<td>Continuous Playback</td>
<td>110 minutes</td>
<td>280 minutes</td>
<td>160 minutes</td>
</tr>
<tr>
<td>Continuous Recording</td>
<td>400 shots</td>
<td>1020 shots</td>
<td>620 shots</td>
</tr>
</tbody>
</table>

● About rechargeable batteries
- Use only the nickel-metal hydride batteries (NP-H3) that are available from your dealer as options for this camera. Proper camera operation is not guaranteed when other rechargeable batteries are used.
  - Nickel-metal hydride Batteries (4-battery set)/Quick Charger Set BC-1HB4
  - Nickel-metal hydride Batteries (4-battery set) NP-H3P4
- Be sure to keep all four batteries together as a set at all times, for both charging and powering the camera. Mixing batteries from different sets can shorten overall battery life and cause malfunction of the camera.
- Rechargeable batteries cannot be charged while they are loaded in the camera.

● Tips for Prolonging Battery Life
- Use the button to turn off the flash when you are not using it.
- You can also use the power save settings (E-42) to protect against wasting battery power when you forget to turn off the camera.

● How low temperature affects battery life
- The life of alkaline batteries is shortened by use under very cold temperatures. The life of alkaline batteries used at 0°C is about one fifth of what it is at normal temperatures (about 25°C). When shooting under very cold temperatures, we recommend use of lithium or nickel metal hydride batteries, which are not so dramatically affected by cold. If you must use alkaline batteries, be sure to have plenty of spares on hand.
Battery Handling Precautions

Incorrect use or handling of batteries can cause them to leak or burst and seriously damage your camera. Be sure to note the following important precautions to avoid problems with batteries.

- Dead batteries are susceptible to leakage, which can cause serious damage to your camera. Remove batteries from the camera as soon as you notice they are dead.
- The batteries that power the camera normally become warm as they discharge.

- Use only LR6 (AM-3) type alkaline or FR6 type lithium or Ni-MH (nickel-metal hydride) dry cell batteries with this camera. Never mix old batteries with new ones. Doing so can result in bursting or leaking of batteries, creating the danger of fire or personal injury.
- Always make sure that the positive (+) and negative (−) ends of the batteries are facing correctly, as noted by the markings on the camera itself. Improper loading of batteries can result in bursting or leaking of batteries, creating the danger of personal injury or soiling of objects nearby.

- Remove batteries from the camera if you do not plan to use it for more than two weeks.
- Never recharge batteries, never allow direct connection between two ends of a battery, and never try to take batteries apart.
- Do not expose batteries to direct heat or dispose of them by burning. Doing so can create the danger of explosion.
- Never mix batteries of different types.

Battery Capacity Indicator

The battery capacity indicator (shown only when the image information display is turned on) changes in the following sequence as battery power decreases: “�” → “” → “” → “”. If you continue to use the camera while the battery level is “” or “”, camera power will automatically turn off.
Auto Power Off  
(Battery Powered Operation Only)

Power automatically turns off whenever you do not perform any camera operation for a specific period. See page E-43 for details about how you can specify the Auto Power Off time.
• To restore power, simply use the POWER Switch to turn power back on again.

IMPORTANT!

The Auto Power Off function does not operate under the following conditions.
• During Slide Show (page E-84)
• While the camera is being operated from a computer or printer connected via a cable or the USB port (page E-98).
• Whenever the AC adaptor is connected to the camera.

Using AC Power

Use the optional AC adaptor (AD-C620) to power the camera from standard AC power.

AC Adaptor precautions

• Never use an electrical outlet whose voltage is outside the rating marked on the AC adaptor. Doing so can create the danger of fire or electrical shock. Use only the optional AC adaptor specified for this camera.
• Should the cord of the AC adaptor become damaged (exposed internal wiring), request a replacement from an authorized CASIO service provider. A damaged AC adaptor cord creates the danger of fire or electrical shock.
POWER SUPPLY

- Always be sure to use the AD-C620 AC adaptor only. Using any other AC adaptor can cause damage to the camera not covered by the warranty.
- When unplugging the AC adaptor from the wall socket, be sure to grasp the adaptor (not the cord).
- Avoid any undue bending, pulling, and twisting of the AC adaptor’s cord, and never try to lengthen the cord by splicing it with other wire.

- Be sure to turn power off before connecting or disconnecting the adaptor.
- Always turn camera power off before disconnecting the AC adaptor, even if the camera has batteries installed. If you don’t, the camera will turn off automatically when you disconnect the AC adaptor. You also run the risk of damaging the camera whenever you disconnect the AC adaptor without first turning power off.
- The AC adaptor may become warm to the touch after extended periods of use. This is normal and is not cause for alarm.
- After using the camera, turn it off and unplug the adaptor from the AC outlet.
- The camera automatically switches over to AC adaptor powered operation whenever the AC adaptor is plugged into the camera.
- Always use the AC adaptor to power the camera whenever it is connected to a computer.

CAUTION

SLEEP ..................
The monitor screen enters a sleep state if no operation is performed for a specified amount of time in the Record Mode. Pressing any button restores full power. You can specify 30 seconds, 1 minute, or 2 minutes before the sleep state is triggered, or you can turn off this setting entirely.

AUTO POWER OFF ........ Auto Power Off turns off camera power if no operation is performed for a specified amount of time. You can specify 2 minutes, 5 minutes, or 10 minutes before AUTO POWER OFF is triggered, or you can turn off this setting entirely.

• AUTO POWER OFF takes priority when both SLEEP and AUTO POWER OFF are both set for a 2-minute trigger time. This means camera power turns off if no operation is performed after two minutes.

Power Save Settings

The settings described below let you specify sleep and auto power off trigger times that help to conserve valuable battery power.
Setting SLEEP and AUTO POWER OFF Trigger Times

1. Slide the Function Switch to REC.
2. Press MENU.
3. Select “Options” → “Power Save” → “Power Save”.
   - “Options” appears on the advanced menu only.
4. Use [+ ] and [– ] to select “Sleep” or “Auto Power Off”.
5. Select the trigger time you want to set.
6. When the settings are the way you want them, press the shutter button.
7. Select “Exit”.

Initializing Power Save Trigger Times

Use the following procedure to return SLEEP and AUTO POWER OFF trigger time settings to their initial factory defaults (SLEEP: 1 minute, AUTO POWER OFF: 2 minutes).

**IMPORTANT!**

Note that performing the following procedure to initialize the power save trigger time settings also initializes mode memory (page E-74).

1. Slide the Function Switch to REC.
2. Press MENU.
3. Select “Options” → “Power Save” → “Power Save”.
   - “Options” appears on the advanced menu only.
4. Use [+ ] or [– ] to select “Sleep” or “Auto Power Off”.
5. Select “Restore”.
6. Select “Exit”.
Use the following procedures to set the current date and time, and to select the date format. When you record an image, the time and date the image was shot is registered in accordance with data from the camera’s built-in clock. You can even use the TIME STAMP function to “stamp” the date and time inside the image.

**IMPORTANT!**

- The time and date settings are cleared if the camera is left for about 24 hours without battery and AC power being supplied. If this happens, restore power and make new time and date settings before using the camera again.
- A flashing time display indicates that the time and date (clock) settings have been cleared. Use the procedure on this page to make the correct time and date settings.
- If you do not set the camera’s built-in clock to the current date and time, all images are recorded with the default date and time, which probably is not your correct current date and time. Be sure to correctly set the clock before you use the camera.

### Setting the Date and Time

1. Press **MENU**.
2. Select “Set Up” → “Date” → “Adjust”.
3. Set the current date and time.
   - Use [+][–] to select the green setting on the monitor screen, and then press the shutter to advance to the next setting. Repeat this for all of the settings on the monitor screen.
4. After making all the settings on the monitor screen, press **DISP** to register them.
Selecting the Date Format

Example: Sep 12, 1999

You can select any one of the following formats for the above date: 99/9/12, 12/9/99, 9/12/99.

1. Press MENU.

2. Select “Set Up” → “Date” → “Style”.

3. Use [+]- and [−] to select the date format you want, and then press the shutter button.
Using the Shutter Button

The following steps describe how to operate the shutter button so that Auto Focus has a chance to focus the image.

1. Press the shutter button about half way.
   - The Auto Focus feature automatically focuses the image.

2. Press the shutter button as far as it will go to record the image.

Basic Recording Operation

The following describes the basic operation for recording images.

1. Slide the Function Switch to REC.
   - The REC position selects the Record Mode, while PLAY selects the Playback Mode.

2. Rotate the dial so its (normal recording) setting is aligned with the dot on the top of the camera.

3. Slide the POWER Switch in the direction indicated by the arrow.
• The POWER Switch returns to its original position when you release it.
• Turning on power enters the Record Mode.
• If power turns off, use the POWER Switch to turn it back on again.

4. After composing the image on the monitor screen, press the shutter button about half way and hold it there.

• The camera’s Auto Focus feature automatically focuses the image.
• The operation lamp lights green and the Auto Focus Frame in the monitor screen turns green when the Auto Focus operation is complete.
• Take care to avoid blocking the lens, distance sensor or light sensor with your fingers.

• Carefully press the shutter button, taking care not to move the camera as you do.

5. After confirming that the Auto Focus operation is complete (the operation lamp lights green), press the shutter button all the way down to record the image.

• Pressing the shutter button releases the shutter, even if Auto Focus was unsuccessful and the image is out of focus.
• After you record an image, the camera takes a few seconds to store it in memory. If you try to change to the Playback Mode while a save operation is in progress, the message “Press DISP to cancel save” appears on the monitor screen. Pressing DISP at this time cancels the save operation.
• Use of a tripod and the wired remote controller is recommended for slow shutter speeds and telephoto shots to avoid blurring of the image due to camera movement.
RECORDING

IMPORTANT!

Auto Focus tends not to work well with the following types of subjects.

- Solid color walls or objects with little contrast
- Strongly backlit objects
- Polished metal or other brightly reflective objects
- Venetian blinds or other horizontally repeating patterns
- Multiple images that are varying distances from the camera
- Subjects in poorly lit areas
- Auto Focus also may not work properly when the camera is unsteady or shaking.

These cases may make it impossible for Auto Focus to focus properly, which is indicated by the operation indicator and the Auto Focus Frame inside the monitor screen remaining red. When this happens switch to the Manual Mode for focusing (page E-59). The following are the fixed focusing distances when Auto Focus is unable to focus.

- Well-lit Location: 1.5 meters minimum
- With Flash: Approximately 2 meters

CAUTION

- Never open the battery compartment cover, disconnect the AC adaptor from the camera, or unplug the adaptor from the wall socket while the operation indicator is flashing green. Doing so will not only make storage of the current image impossible, it can also corrupt other image data already stored in camera memory.
- Fluorescent lighting actually flickers at a frequency that cannot be detected by the human eye. When using the camera indoors under such lighting, you may experience some brightness or color problems with recorded images.
Using Focus Lock

Normally, Auto Focus automatically focuses on the object that is inside the Auto Focus Frame. Focus lock is a technique that lets you lock the focus on a subject and then move the camera so the Auto Focus Frame is pointed at another subject when you record. This keeps the original subject in focus, even though a different object is within the Auto Focus Frame.

- Locking the focus also locks the exposure setting.

1. Align the Auto Focus Frame with the subject you want to lock on and press the shutter button half way down.
   - The Auto Focus frame turns green when the image is in focus.
   - If you are using the wired remote controller, press its FOCUS LOCK ON/OFF button to turn focus lock on and off.

2. While keeping the shutter button depressed half way, move the camera and compose the image as you want.

3. Press the shutter button all the way down to record the image.
Using the Flash

You can use the built-in flash unit to provide illumination during recording.

1. Slide the Function Switch to REC.

2. Press $\$\$\$ button.
   - Each press of $\$\$\$ cycles through the flash mode in the following sequence: Auto → On → Off → Red-eye Reduction.

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Flash Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Auto Flash</td>
<td>Flash is automatically enabled and disabled in accordance with exposure conditions.</td>
</tr>
<tr>
<td>$$$$$</td>
<td>Flash On</td>
<td>Flash is always fired, regardless of exposure conditions.</td>
</tr>
<tr>
<td>$$$$$</td>
<td>Flash Off</td>
<td>Flash is never fired, regardless of exposure conditions.</td>
</tr>
<tr>
<td>$$$$$</td>
<td>Red-eye Reduction</td>
<td>Fires a pre-flash followed by recording with flash, which reduces the chance of red-eye.</td>
</tr>
</tbody>
</table>

- The monitor screen goes blank and the operation lamp flashes amber while the flash unit is charging.

Camera Shake Indicator

The $\$\$\$ (camera shake indicator) appears on the monitor screen when the ZOOM slider is set to T (telephoto) or when a slow shutter speed is being used.
- If the camera shake indicator $\$\$\$ appears, use a tripod and the wired remote controller to avoid camera movement.

Flash Indicator

When you press the shutter button half way, the flash icon appears on the monitor screen to indicate that the flash will fire when shutter button is pressed the rest of the way down.

IMPORTANT!
- Never use the flash in areas where combustible or explosive gas is present. Doing so creates the danger of fire and explosion.
- Never fire the flash in the direction of a person operating a motor vehicle. Doing so can interfere with the driver’s vision and create the danger of accident.
• Never fire the flash while it is too close to the subject’s eyes. Intense light from the flash can cause eye damage if it is fired too close to the eyes, especially with young children. When using the flash, the camera should be at least one meter from the eyes of the subject.
• Make sure that you do not touch or block the flash or light sensor with your fingers. Doing so can soil these components and interfere with correct flash operation.

• Flash should be used for distances in the ranges shown below. Flash does not work well outside these ranges.
  - Normal: Approximately 0.5 meters to 2.5 meters
  - Macro: Approximately 0.1 meters to 0.5 meters

• Depending on operating conditions (type of battery being used, temperature, etc.), it may take up to 10 seconds for the flash unit to charge.

• The flash is disabled in the Movie Mode. This is indicated by the indicator.
• The flash unit will not charge when battery power is low. The indicator appears to warn you that the flash will not fire correctly, which may affect exposure of the image. Replace batteries as soon as possible when this happens.
• Red-eye reduction may not work well when the camera is not pointed directly at the subject or when the subject is far from the camera.
• In the Red-eye Reduction Mode, the flash is fired automatically in accordance with exposure. Because of this, the flash will not fire in a well-lit area.
• White balance is fixed while the flash is being used, so the coloring of the recorded image may be affected by sunlight, fluorescent lighting, or other sources of illumination in the immediate area.
Changing the Lens Orientation

The lens of the camera is built into a rotating lens body. This means you can change the angle of the lens without moving the rest of the camera.

- Any images recorded while the lens body is rotated so the lens is pointed towards the back of the camera are stored as mirror images of the image that appears in the LCD before the shutter button is pressed.

IMPORTANT!

- Do not apply excessive force when rotating the lens body. Doing so can cause serious damage to the lens.
- Do not carry the camera or move it around while holding onto only the lens body.
- Return the lens body to its normal position (with the lens point up) before storing the camera.
- Never lay the camera down or store it with the lens pointing downwards. Doing so can cause bending of the ring around the outside of the lens.
- Always leave the lens cap in place on the lens except when actually using the camera for recording.
Quality Settings

The camera has three quality modes: FINE, NORMAL, ECONOMY.

- To determine the number of images that can be stored on a memory card of a different capacity, multiply the capacities in the table below, by the appropriate value.
- The actual number of images that can be stored in memory cannot be specified precisely because the amount of memory required for storage of each image differs according to image contents.

- Numbers in parentheses are compressed image file sizes.
- The figures in the left are approximations only. The actual number of images depends on image subject matter.

Use the procedure under “Using the Record Menus” on page E-75 for details on changing the quality modes.

- Note that the maximum number of images that can be stored in a single folder is 250. Because of this, even if you are using a card that allows storage of more than 250 images, the camera’s monitor screen will show capacity for up to 250 images only. You will be able to store additional images by changing to another folder.

- The number of images that can be recorded may differ when you use card browser (page E-106).

<table>
<thead>
<tr>
<th>Setting Indicator</th>
<th>FINE</th>
<th>NORMAL</th>
<th>ECONOMY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quality</td>
<td>Fine</td>
<td>Normal</td>
<td>Economy</td>
</tr>
<tr>
<td>Computer Image size</td>
<td>1280 X 960 pixels</td>
<td>640 X 480 pixels</td>
<td>1280 X 960 pixels</td>
</tr>
<tr>
<td>Number of Images 8MB memory card</td>
<td>13</td>
<td>39</td>
<td>16</td>
</tr>
<tr>
<td>Number of Images 48MB memory card (Option)</td>
<td>88</td>
<td>268</td>
<td>122</td>
</tr>
<tr>
<td>File Size (per image)</td>
<td>500 KB</td>
<td>150 KB</td>
<td>350 KB</td>
</tr>
</tbody>
</table>
### Exposure Compensation

This camera features an program AE function that automatically changes shutter speed and aperture in accordance with available light. In addition, you can also manually adjust the exposure to compensate for backlighting, indirect indoor lighting, dark backgrounds, and other special conditions.

1. **Slide the Function Switch to REC.**

2. **Use [+] and [–] to perform exposure compensation.**
   - Pressing [+] or [–] displays an EV indicator that shows the current exposure compensation setting.
   - Pressing [+] makes the image on the monitor screen brighter. Use it to adjust for dim indoor lighting and backlighting.
   - Pressing [–] makes the image on the monitor screen darker. Use it to adjust for bright sunlight.
   - The EV indicator turns red whenever the compensation value is at its limit.

3. **After adjusting the exposure, press the shutter button to record the image.**

### NOTES

- Exposure compensation is generally expressed in terms of an exposure compensation (EV) value. The exposure compensation value is always set to zero whenever you turn on the camera.
- Each press of [+] or [–] changes the exposure compensation value by 0.25EV. A change in either direction is indicated on the monitor screen by arrows pointing left (negative correction) or right (positive correction).
- The normal maximum range for exposure compensation is –2EV to +2EV. Under certain conditions, however, the camera may impose lower maximum values when exposure compensation would result in an image that is too dark or too light.
• The exposure compensation value automatically reverts to zero whenever the shutter button is pressed. You can manually reset the exposure compensation value by using [+] and [–] to change the value back to zero, which is indicated when the EV indicator disappears from the monitor. EV value is fixed during panorama recording.
This section describes more advanced recording operations that are also provided by this camera.

### Using Quick Shutter

Quick Shutter lets you record up to five images at intervals of approximately one second. Quick Shutter can be used to record normal, Night Scene Mode, Landscape Mode, or Portrait Mode images.

**IMPORTANT!**

- The operation lamp flashes while data is being written to the memory card. Never remove the memory card from the camera while this lamp is flashing.
- Quick shutter is disabled under any of the following conditions: while the flash is charging, while a slow shutter speed is being used, and when conditions cause Auto Focus to take a long time to finish.
- Even if Quick Shutter is enabled, the camera automatically uses the Single shutter mode whenever the battery level is “♭♭♭♭♭♭”.
- If you use the dial to try to change to another recording mode while the camera is saving buffer data to the memory card, the mode will not change to another recording mode until the data transfer and the save operation is complete.

1. Slide the Function Switch to REC.

2. Select “Functions 1” → “Shutter Mode” → “Quick”.
   - “Functions 1” appears on the advanced menu only.
   - Turning on “Quick” causes “○○○○○” to appear under the quality indicator.

3. Press the shutter button.
   - The ○ marks sequentially change to ● marks as images are recorded.
   - Images you record using Quick Shutter are initially stored in a buffer, and then sequentially transferred to the memory card. Images continue to be recorded as long as you hold down the shutter button or until the buffer becomes full (five images). The buffer may be able to hold only four images when you are using the Night Scene Mode or a slow shutter speed.
Continuous Recording

With continuous recording, you can hold down the shutter button and record up to five images at an interval of about 0.25 seconds. Continuous recording can be used for normal recording, as well as in the Night Scene, Landscape, and Portrait modes.

1. Slide the Function Switch to REC.

2. Press MENU.

3. Select “Functions 1” → “Shutter Mode” → “Continuous”, and then press the shutter button.
   • “Functions 1” appears on the advanced menu only.
   • The “لحق” indicator is on the monitor screen while the Continuous Mode is selected.

4. Compose the image and then record it.
   • Focus is locked when you record the first image, and this setting is applied to all subsequent images.
   • The flash does not fire in the Continuous Mode.
   • The interval of Continuous Mode shots may be longer than 0.25 seconds at slower shutter speeds.
   • You may be able to record only four images in the Continuous Mode when using the Night Scene Mode, a fixed shutter speed, or a slow shutter speed.
   • Do not start a Continuous Record operation when the low battery indicator is on the monitor screen.
   • Storage of images recorded in the Continuous Mode to a memory card can take about 10 seconds (for five images).
   • Never remove camera batteries, unplug the AC adapter from the camera, or remove the memory card while images are being saved.
Using the Zoom Features

The zoom features let you move in closer on subjects that are located far from the camera. You can choose either optical zoom or digital zoom, or even use them in combination to increase the size of the original image by 16 or 32 times its original size.

Using Optical Zoom

Optical zoom enlarges the image by changing the focal distance of the lens.
You can increase the size of the image by eight times using optical zoom.

1. Slide the Function Switch to REC.

2. Move the ZOOM slider towards T (telephoto) to zoom in on the subject, or W (wide-angle) to zoom out.
   - The camera performs an Auto Focus operation if you move the ZOOM slider towards T (telephoto).

3. Compose the image and then record it.
   - Brightness (aperture) is also affected by using optical zoom.
   - Use of a tripod and the wired remote controller is recommended for slow shutter speeds and telephoto shots to avoid blurring of the image due to camera movement.
OTHER RECORDING FUNCTIONS

Using Digital Zoom

Digital zoom produces a VGA size image (640 x 480 pixels) that can be double or four times the size of the original image.

Using digital zoom and optical zoom in combination can zoom an image to 32X.

IMPORTANT!

- The focus range for Auto Focus depends on the optical zoom setting as shown below.

<table>
<thead>
<tr>
<th>Optical Zoom</th>
<th>Focus Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>X1 to X8</td>
<td>0.4m to ∞</td>
</tr>
</tbody>
</table>

- The camera may not be able to focus on an image if the subject is closer than the distances noted above. Use the macro mode for very close subjects.
- Note that 4X digital zoom produces a relatively rougher image than OFF or 2X when used in combination with Auto Focus.

See “Using the Record Menus” on page E-75 for details on making digital zoom settings.

Manual Focus

Manual Focus lets you manually adjust the focus of an image.

1. Slide the Function Switch to REC.

2. Press MF/∞/macro a number of times until the MF indicator appears on the monitor screen.
   - Each press of MF/∞/macro cycles the focus mode in the following sequence: Auto Focus → Manual Focus (MF) → Infinity (∞) → Macro (macro).

3. While “MF” is flashing on the monitor screen, use [+] and [–] to focus the image.
   - If you do not perform any focus operation for about two seconds, the “MF” indicator stops flashing.
   - After “MF” stops flashing, you can use [+] and [–] to adjust exposure compensation (EV).
   - If “MF” stops flashing before you have a chance to focus, press MF/∞/macro to make “MF” flash again.
   - Pressing MF/∞/macro while “MF” is flashing changes the focus mode to Infinity.
OTHER RECORDING FUNCTIONS

4. Compose the image and then record it.
   • The operation lamp and the Auto Focus frame do not appear while manual focus is in use.

Infinity Mode Recording

Use the Infinity Mode when recording images of scenery or objects that are far away. This mode performs Auto Focus in the vicinity of \( \infty \) (infinity).

1. Slide the Function Switch to REC.

2. Press \( MF/\infty/ \) a number of times until the \( \infty \) indicator appears on the display.
   • Each press of \( MF/\infty/ \) cycles the focus mode in the following sequence: Auto Focus \( \rightarrow \) Manual Focus (MF) \( \rightarrow \) Infinity (\( \infty \)) \( \rightarrow \) Macro (\( \otimes \)).

3. Compose the image and then record it.
OTHER RECORDING FUNCTIONS

Using the Macro Mode

With the macro mode, you can record close up images of subjects located only 1 cm to 50 cm from the filter frame.
• In the macro mode, optical zoom is limited to the range of x1 to x1.6.

1. Slide the Function Switch to REC.

2. Press MF/∞/📸 a number of times until the 📸 indicator appears on the monitor screen.
• Each press of MF/∞/📸 cycles the focus mode in the following sequence: Auto Focus → Manual Focus (MF) → Infinity (∞) → Macro (📸).

3. Compose the image and then record it.

Movie Recording

You can record movies that are approximately 10 seconds long. Movies are recorded in 320 x 240-pixel AVI format. For details, see “Using the Record Menus” on page E-75.

There are two types of movie recording: PAST and NORMAL. PAST lets you capture images of events that occurred before you pressed the shutter button while NORMAL records what happens after you press the shutter button.

See “Using the Record Menus” on page E-75 for details on how to select the movie length.
• AVI files can be displayed and saved on a computer that is set up to support use of CompactFlash cards. For such a computer, install QuickTime 3, which comes bundled with the camera.

NORMAL

1. Slide the Function Switch to REC.
2. Align the dial with 📼 to select Movie Recording Mode.

3. Compose the image and then record it.
   - Auto Focus automatically adjusts in accordance with the movement of the subject.
   - See “Playing Back a Movie” on page E-80 for details on playing back a movie.
   - Movie recording stops automatically 10 seconds after you start the record operation.
   - To stop recording before the 10-second period is up, press the shutter button.

PAST

1. Slide the Function Switch to REC.

2. Select “Movie Mode” → “Past”.
   - On the advanced menu, select “Functions 2” → “Movie Mode” → “Past”.

3. Align the dial with 📼 to select Movie Recording Mode.

4. Compose the image on the monitor screen and then press the shutter button about half way.
   - Auto Focus automatically adjusts in accordance with the movement of the subject.
   - The message “STAND BY” appears on the monitor screen to indicate that the camera’s buffer memory is accumulating image data. This message remains displayed for about 10 seconds.
   - After “STAND BY” disappears from the monitor screen, the contents of the buffer memory continues to be updated as long as you keep the shutter button depressed about half way.
5. Keep the camera pointed at the action you want to record, and press the shutter button all the way down when you want to end recording.

- Pressing the shutter button after “STAND BY” disappears from the monitor screen records everything that went on in front of the lens during the 10-second period before you pressed the shutter button.

- Pressing the shutter button while “STAND BY” is still on the monitor screen records everything that went on in front of the lens during the period from when you pressed the shutter button half way down and when you pressed it all the way down. In this case, the recording will be less than 10 seconds long.

**IMPORTANT!**
Flash is disabled during movie recording.

**NOTE**
Movie Storage Capacity

<table>
<thead>
<tr>
<th>Storage Capacity</th>
<th>Approximately 300KB/second</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recording Time</td>
<td>10 seconds per movie</td>
</tr>
</tbody>
</table>

* When using 8MB CF card.
Panorama Recording

With panorama recording you record a series of images and then link them to create a single panoramic effect.

1. Slide the Function Switch to REC.

2. Align the dial with \( \) to select Panorama Recording Mode.

3. Compose the image and then record it.
   - The right edge of the previous image you recorded remains on the monitor screen, so you can align it correctly with the next image.
   - From the second image onwards, aim the camera further to the right and overlap the next image with the previous one on the monitor screen.
   - Up to nine images can be grouped into a panorama. Press MENU when you want to stop a panorama recording operation.
   - When the lens is pointing in the same direction as the monitor screen, the right edges of the previous image you recorded remains on the monitor screen.
   - Aperture setting and white balance settings are locked when you record the first image of a panorama, and these settings are applied to all subsequent images in that panorama.
   - If you want to link more than 9 images into a panorama, upload the images to a computer and use your computer application to link them.
   - See “Panorama Playback” on page E-81 for details on playing back panoramas.
OTHER RECORDING FUNCTIONS

The Night Scene Mode is for recording images in dark areas. When recording images of people on a twilight or night time background, you can use the flash in combination with the Night Scene Mode for slow synchro recording.

1. Slide the Function Switch to REC.

2. Align the dial with 🌙.

3. Compose the image and then record it.

IMPORTANT!
- The maximum shutter speed in the Night Scene Mode is one second. Set the shutter speed manually (page E-70) when you want to use a slower speed.
- The shutter speed is quite slow in the Night Scene Mode, so you should be sure to use a tripod to hold the camera steady.
- Slow shutter speed also causes slow monitor screen refresh. Because of this, the image recorded may be slightly different from the image that was on the monitor screen when you pressed the shutter button.
- Auto Focus is difficult in the dark. If you experience problems, use manual focusing (page E-59). There may be some blurring of the image if the subject is fast moving.
- In the Night Scene Mode, Quick Shutter records up to 4 consecutive shots.
- The contrast of Night Scene Mode images is not affected by changes made using the Record Menu's Contrast (Record Settings) settings.
Landscape Mode Recording

The Landscape Mode provides clear images from close ups to telephoto. The Landscape Mode records images where everything is in clear focus, from the foreground to the background. You can use the Landscape Mode with the ZOOM slider towards W (wide-angle) to record wide-angle images with clear focus from foreground to background.

1. Slide the Function Switch to REC.
2. Align the dial with 🡱.
3. Compose the image and then record it.

Monochrome and Sepia Recording

Use the following procedure to record an image in monochrome (black and white) or sepia. Note that you cannot convert an image to color after recording it in monochrome or sepia.

1. Slide the Function Switch to REC.
2. Press MENU.
3. Use [+] and [-] to select “Color” and then press the shutter button.
   - On the advanced menu, select “Functions 2” → “Color.”
4. Use [+ ] and [− ] to select “B/W” or “Sepia” and then press the shutter button.

5. Compose the image and then record it.

---

**Portrait Recording**

In the Portrait Mode, focus is adjusted so the background is slightly blurred, which highlights the subject in the foreground.

1. Slide the Function Switch to REC.

2. Align the dial with 📸 .

3. Compose the image and then press the shutter button about half way down.

4. After confirming that the subject is in focus, press the shutter button all the way down.
Using the Self-timer

You can use the self-timer for either of the two following recording operations.

10-second recording .... Records about 10 seconds after the shutter button is pressed. Use this method when you want to be included in the image that is recorded.

2-second recording ...... Records about 2 seconds after the shutter button is pressed. Use this method to avoid camera movement caused when the shutter button is pressed.

1. Slide the Function Switch to REC.

2. Press 📸.
   - The self-timer is disabled while the Shutter Speed is set to “Bulb”.

3. Compose the image and then record it.

NOTE

During self-timer recording, you may find it helpful to rotate the swivel lens mechanism so the monitor screen faces the same direction as the lens. This way you can always see how much time is left until the start time is reached and recording begins.
Using the Timer

You can use the timer to perform any one of the following operations.

- **Interval Recording**
  Use this method to record a series of images at fixed time intervals.

- **Timer Recording**
  Use this method to record a single image after passage of a fixed amount of time.

- **Interval Timer Recording**
  Use this method to record a series of images at fixed time intervals, starting after passage of a fixed amount of time.

1. Slide the Function Switch to REC.

2. Align the dial with  to select timer recording.

3. Specify the number of images (Shots), the interval between shots (Interval), and the record start time (Start time).
   - Shots .......... 250 maximum
   - Interval ........ 1 to 60 minutes
   - Start time .... Current time to current time plus 24
   - The Interval cannot be specified when 1 is specified for Shots.

4. Compose the image and then record it.
   - When the start time you set is reached, the operation lamp lights and image recording starts.
   - The monitor screen of the camera turns off between shots of a timer operation. If you turn on camera power during this time, the message “TIMER CANCEL” appears and the timer operation is cancelled.
**OTHER RECORDING FUNCTIONS**

**IMPORTANT!**
- The “Bulb” Shutter Speed setting cannot be used with a timer operation. If the Shutter Speed setting is “Bulb” it automatically changes to “Auto” when you select the timer with the dial.
- The camera requires a certain amount of time to store an image in memory after it is recorded. Because of this, setting a shutter speed of “24 sec” or higher and an interval of “01 min” may result in an interval that is longer than one minute.

**Shutter Speed Priority Image Recording**
You can fix the shutter speed at a specific level.

**Auto:** Automatic shutter speed setting in accordance with subject

**Manual range:** Bulb, 64 to 1/2000 second

- You can fix both the shutter speed and aperture (page E-71).
- For shutter speed priority recording, set the “Aperture” setting to “Auto”.

1. Slide the function switch to REC.
2. Press MENU.
3. Select “Functions 1” → “Shutter Speed” → “Manual”.
   - “Functions 1” appears on the advanced menu only.
4. Use [+] and [–] to select the shutter speed setting you want to use and then press the shutter button.
5. Select “Exit”.

**IMPORTANT!**
- The “Bulb” Shutter Speed setting cannot be used with a timer operation. If the Shutter Speed setting is “Bulb” it automatically changes to “Auto” when you select the timer with the dial.
- The camera requires a certain amount of time to store an image in memory after it is recorded. Because of this, setting a shutter speed of “24 sec” or higher and an interval of “01 min” may result in an interval that is longer than one minute.
6. Compose the image and then record it.
   • When the Shutter Speed is set to “Bulb”, exposure continues as long as you depress the shutter button. Because of this, use of the wired remote control unit is recommended whenever using the “Bulb” setting.
   • The self-timer is disabled while the Shutter Speed is set to “Bulb”.
   • The slowest shutter speed when “Bulb” is selected is 64 seconds.
   • Note that using a slower shutter speed increases the chance of static being present in your image, and the amount of static visible in an image is inversely proportional to the shutter speed.
   • At shutter speeds of one second or slower, the camera automatically performs internal data processing intended to limit image static, so the image record operation takes longer at slow shutter speeds. At shutter speeds of one second or greater, doubling the shutter speed setting tells you about how long it takes for an image to be recorded. For example, image recording with a shutter speed of one second takes about two seconds.

   **Aperture Priority Image Recording**

   You can fix the aperture at a specific level. A larger aperture (indicated by a smaller aperture value) narrows the focus range, while a smaller aperture widens the focus range.

   **Wide aperture (F3.2)  Decreased aperture (F8)**

   Manual settings: F3.2, F4.8, F8
   Auto: Automatic aperture setting in accordance with subject

   • You can fix both the aperture and shutter speed (page E-70).
   • For shutter speed priority recording, set the “Shutter Speed” setting to “Auto”.
   • Adjust the aperture setting to compensate for the relative brightness or darkness of the subject you are recording.

1. Slide the function switch to REC.
2. Press MENU.
3. Select “Functions 1” → “Aperture”.
   • “Functions 1” appears on the advanced menu only.

4. Use [+ ] and [– ] to select the aperture setting you want to use and then press the shutter button.

5. Select “Exit”.

6. Compose the image and then record it.

Performing Manual White Balance

Certain lighting conditions can cause auto white balance to take a very long time or can result in a limitation of the adjustable range (color temperature). If you suspect your current lighting conditions are causing problems, try performing manual white balance. This sets white balance to a level that can be used under any lighting conditions.

The following procedure describes how to perform manual white balance using a white piece of paper. For optimum results, you should use a special reflective plate that should be commercially available from a local camera equipment shop.

1. Slide the Function Switch to REC.

2. Press MENU.

   • “Functions 1” appears on the advanced menu only.
4. Keeping the camera pointed at the white sheet of paper, press DISP to make the manual white balance settings.
   • Pressing the shutter button at this time returns the camera to the white balance setting that was obtained the last time you performed this manual white balance procedure.

5. The manual white balance procedure stops automatically when it is done.
   • If the manual white balance procedure does not end automatically, press the shutter button to interrupt it.

6. After the camera finishes making the white balance setting, it returns to the screen in step 3 above. Select “Exit” to exit the manual white balance procedure.

NOTE
White balance is automatically set to “Day Light” whenever you enter the Night Scene Mode. You can leave this as it is or change it using the above procedure.

---

**Recording Mode Power On Settings**

A power on setting is one that is set by the camera automatically whenever you turn it on. Normally, the camera uses its own built-in power on default settings.

The following table shows the items whose settings you can save in mode memory. Note that the procedure described here only lets you select ON (save current setting in mode memory) or OFF (use the camera’s preset default setting).

<table>
<thead>
<tr>
<th>Mode Memory Item</th>
<th>On</th>
<th>Off</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mode 1 (Mode Memory 1)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Focus</td>
<td>AF, MF, ∞,  ⚫</td>
<td>AF</td>
</tr>
<tr>
<td>Flash</td>
<td>Auto, ⚫, ⚫</td>
<td>Auto</td>
</tr>
<tr>
<td>Digital Zoom</td>
<td>Off, Auto, X2, X4</td>
<td>Auto</td>
</tr>
<tr>
<td>Mode 2 (Mode Memory 2)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Metering</td>
<td>Multi, Center, Spot</td>
<td>Multi</td>
</tr>
<tr>
<td>White Balance</td>
<td>Auto, Day Light, Shade, Tungsten, Fluorescent, Manual</td>
<td>Auto</td>
</tr>
<tr>
<td>Flash Intensity</td>
<td>Strong, Normal, Weak</td>
<td>Normal</td>
</tr>
<tr>
<td>Aperture</td>
<td>Auto, F3.2, F4.8, F8</td>
<td>Auto</td>
</tr>
<tr>
<td>Shutter Speed</td>
<td>Auto, Manual (Bulb, 64 to 1/2000 second)</td>
<td>Auto</td>
</tr>
</tbody>
</table>
Turning power on default settings on and off

1. Slide the Function Switch to REC.
2. Press MENU.
3. Select “Options”.
4. Select “Mode 1” or “Mode 2”.
5. Select “Mode 1” or “Mode 2”.
6. Select the item whose setting you want to change.
7. Select “On” or “Off”.
   • Repeat steps 6 and 7 for other items if you want.
8. Select “Exit”.

Initializing Mode Memory

Use the following procedure to initialize the mode memory.

IMPORTANT!

Note that performing the following procedure to initialize mode memory also initializes power save trigger time settings (page E-43).

1. Perform steps 1 through 3 under “Turning power on default settings on and off”.
   • “Options” appears on the advanced menu only.
2. Select “Power Save”, “Mode 1” or “Mode 2”.
3. Select “Power Save”, “Mode 1” or “Mode 2”.
4. Select “Restore”.
   • The following table shows the mode memory status of each item following the above procedure.
5. Select “Exit”.

<table>
<thead>
<tr>
<th>Item</th>
<th>Mode 1</th>
<th>Mode 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Focus</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>Flash</td>
<td>On</td>
<td>On</td>
</tr>
<tr>
<td>Digital Zoom</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>Restore</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Exit</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
OTHER RECORDING FUNCTIONS

- An item that is “On” stores its current setting in mode memory when camera power is turned off, and restores the setting when power is turned back on again.
- An item that is “Off” uses the camera’s preset power on default setting.

<table>
<thead>
<tr>
<th>Item</th>
<th>Initialized Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Power Save</strong></td>
<td></td>
</tr>
<tr>
<td>Sleep</td>
<td>1 min</td>
</tr>
<tr>
<td>Auto Power Off</td>
<td>2 min</td>
</tr>
</tbody>
</table>

**Mode 1 (Mode Memory 1)**
- Focus: Off (AF)
- Flash: On (Auto)
- Digital Zoom: On (Auto)

**Mode 2 (Mode Memory 2)**
- Metering: On (Multi)
- White Balance: Off (Auto)
- Flash Intensity: Off (Normal)
- Aperture: Off (Normal)
- Shutter Speed: Off (Auto)

### Using the Record Menus

The record menus make it easy to control image quality, white balance, and other settings to suit specific conditions and preferences. Each record menu has two formats: a basic menu and an advanced menu. Press DISP to toggle between the basic menu and advanced menu.

### NOTES

- Focus Mode, Flash Mode, Digital Zoom, Metering, White Balance, Flash Intensity, Shutter Speed, and Aperture settings are retained when camera power is turned off by only if you specify them as such with the Mode 1 and Mode 2 items of the Record Menus. All other settings are retained when you turn off camera power.
- Exposure compensation (E-54) and auto flash (E-50) settings are valid only when the shutter speed and aperture settings are both “Auto”.

### Record Menus

See “Menu Screens” on page E-32 for information about how to use menus.

Basic menu items are indicated by **BASIC**.
# OTHER RECORDING FUNCTIONS

## Picture

| Quality | Use this setting to control the quality of the image.  
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>BASIC</td>
<td>Fine / Normal / Economy</td>
</tr>
</tbody>
</table>

| Size   | You can specify either of two image sizes in pixels.  
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>BASIC</td>
<td>1280 x 960 / 640 x 480</td>
</tr>
</tbody>
</table>

| Sharpness | This setting specifies the sharpness of image outlines.  
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Hard : Sharp outlines</td>
</tr>
<tr>
<td></td>
<td>Normal</td>
</tr>
<tr>
<td></td>
<td>Soft : Soft outlines</td>
</tr>
</tbody>
</table>

| Saturation | This setting controls the intensity of colors.  
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>High : Colors appear deeper</td>
</tr>
<tr>
<td></td>
<td>Normal</td>
</tr>
<tr>
<td></td>
<td>Low : Colors appear lighter</td>
</tr>
</tbody>
</table>

| Contrast   | This setting controls the difference between the light areas and dark areas of the image. Contrast is not applied in the Night Scene Mode.  
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>High : Larger difference between light and dark.</td>
</tr>
<tr>
<td></td>
<td>Normal</td>
</tr>
<tr>
<td></td>
<td>Low : Less difference between light and dark.</td>
</tr>
</tbody>
</table>

## Functions 1

| Aperture | Use this setting when you want to fix the aperture at one of the values shown below.  
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Auto / F3.2 / F4.8 / F8</td>
</tr>
</tbody>
</table>

| Shutter Speed | Use this setting to fix the shutter speed at one of the values shown below.  
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Auto / Manual (Bulb, 64 to 1/2000 second)</td>
</tr>
</tbody>
</table>

| Shutter Mode | This setting specifies how the shutter operates.  
|--------------|----------------------------------------------------------|
| Single       | Records single images at an interval of about three seconds.  
| Quick        | Allows recording of sequential images at an interval of about one second.  
| Continuous   | Allows recording of sequential images at an interval of about 0.25 second while the shutter button is held down.  
|              | With any of the above settings, the interval may be longer at slow shutter speeds.  

| Metering | This setting sets the metering method.  
|----------|----------------------------------------------------------|
| Multi    | Takes readings across the entire image, and provides balanced exposure settings.  
| Center   | Takes reading at the center of the image.                |
OTHER RECORDING FUNCTIONS

Functions 2

<table>
<thead>
<tr>
<th>Movie Mode</th>
<th>Select the movie mode you want to use.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal / Past</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Digital Zoom</th>
<th>This item fixes digital zoom at the setting you want.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off / Auto / X2 / X4</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Color</th>
<th>Use this setting to select the color mode you want.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color / B/W / Sepia</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Grid</th>
<th>This item turns an on-screen grid on or off. The grid can be used to help align image components vertically and horizontally.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off / On</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>White Balance</th>
<th>Use this setting to select the white balance setting that makes the colors of the subject appear most natural.</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Auto / Day Light / Shade / Tungsten / Fluorescent / Manual)</td>
<td></td>
</tr>
<tr>
<td>Day Light : Outdoors</td>
<td></td>
</tr>
<tr>
<td>Shade : Blue tinted sunlight</td>
<td></td>
</tr>
<tr>
<td>Tungsten : Red tinted incandescent light</td>
<td></td>
</tr>
<tr>
<td>Fluorescent : Green tinted fluorescent light</td>
<td></td>
</tr>
<tr>
<td>Manual : Sets up the camera for recording of a white sheet of paper under currently available light (page E-72).</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Flash Intensity</th>
<th>Select the setting for the flash intensity you want to use.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Strong / Normal / Weak</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Time Stamp</th>
<th>Use this item to turn time stamping on and off, and to control the format of the stamp.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off / YMD (Year-Month-Day) / D H:M (Day-Hour-Minutes) / YMD H:M (Year-Month-Day-Hour-Minutes)</td>
<td></td>
</tr>
<tr>
<td>Note that the time stamp cannot be deleted from an image.</td>
<td></td>
</tr>
</tbody>
</table>
## OTHER RECORDING FUNCTIONS

### Options

| Power Save | This item can be used to make power save settings to preserve battery power.  
Sleep (Off / 30sec / 1min / 2min) / Auto Power Off (Off / 2min / 5min / 10min) |
|------------|-----------------------------------------------------------------------------|

### Mode 1

Use this item to specify which of the following settings are retained when camera power is turned off.  
Focus / Flash / Digital Zoom

### Mode 2

Use this item to specify which of the following settings are retained when camera power is turned off.  
Metering / White Balance / Flash Intensity / Aperture / Shutter Speed

### Set Up

| Card Browser | Use this item to select the card browser file type.  
Off / Type1 / Type2 / Type3 / Type4 |
|--------------|-----------------------------------------------------------------------------|

<table>
<thead>
<tr>
<th>Format</th>
<th>Select this item to format a memory card.</th>
</tr>
</thead>
</table>

| Date | Use this item to specify the format of the date that appears in the monitor screen, and to adjust the date setting.  
Style (Year/Month/Day / Day/Month/Year / Month/Day/Year) / Adjust |
|------|--------------------------------------------------------------------------------|

| Video Out | This item can be used to specify the format of the video output signal.  
NTSC: Video format in the United States and Japan  
PAL: Video format in Europe and other areas |
|-----------|--------------------------------------------------------------------------------|

<table>
<thead>
<tr>
<th>Language</th>
<th>This setting lets you select either English or Japanese as the display language.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Beep</th>
<th>Use this item to turn the key input confirmation tone on and off.</th>
</tr>
</thead>
</table>
The following describes the different techniques that you can use to playback recorded images.

### Basic Playback Operation

The built-in monitor screen of the camera lets you play back recorded images without connecting an external monitor.

1. **Slide the Function Switch to PLAY.**

2. **Use [+ and – to scroll through the images stored in camera memory.**
   - Press [+] to scroll forward and [–] to scroll back. Holding down either button scrolls at high speed.

### NOTES

- Sliding the Function Switch to PLAY immediately after recording an image displays the image you just recorded first.
- Pressing the shutter button while a movie or panorama image is on the monitor screen starts playback of the movie or panorama.
- The image that initially appears on the monitor screen in the PLAY mode is a preview image. The full of image appears after a few seconds. Images copied from another digital camera or a computer may take longer time to appear.
PLAYBACK

Playing Back a Movie

Use the following operation to play back a movie that was recorded using the operation under “Movie Recording” on page E-61.

1. Slide the Function Switch to PLAY.

2. Use [+] and [–] to select the movie you want to play back.

3. Press the shutter button to start playing back the movie.
   - You can use [+] (forward) and [–] (reverse) while playing back a movie to change the playback direction.

4. After the movie is complete, press MENU.

- To enlarge the movie image so it fills the entire monitor screen, press DISP. Pressing the DISP again returns the image to its original small size.
- Pressing the shutter button during movie play pauses playback. Press the shutter button again to resume playback.
- While movie playback is paused, you can use [+] (forward) and [–] (reverse) to move frame-by-frame through the movie.
Panorama Playback

Use the following operation to playback panoramas recorded using the operation under “Panorama Recording” on page E-64.

1. Slide the Function Switch to PLAY.

2. Use [+ ] and [– ] to select the panorama you want to play back.

3. Press the shutter button to start panorama playback.
   - You can change the direction of a panorama that is playing back by pressing [+ ] or [– ].

4. Press MENU to stop panorama playback.

- Pressing DISP changes to a small-image display. Press DISP again to return to the full-screen size.
- Pressing the shutter button during panorama play pauses playback. Press the shutter button again to resume playback.
- While panorama playback is paused, you can use [+ ] (forward) and [– ] (reverse) to move frame-by-frame through the panorama.
Using Zoom

The following operation lets you magnify an image to twice its normal size. Note that you can zoom only a single still image.

IMPORTANT!
Movie and panorama images cannot be zoomed.

1. Slide the Function Switch to PLAY.
2. Use [+] and [–] to select the image you want to zoom.
3. Press MENU.
4. Select “Zoom”.
   • On the advanced menu, select “View” → “Zoom”.
5. Specify the area.
   • The portion of the selected area appears on the display at twice its normal size.
   • Use [+] and [–] to move the area selection frame left and right. Use ¼ and MF/∞/MENTS to move it up and down.
   • Press the DISP button to toggle on-screen guidance on and off.
6. To return the image to its normal size, press any button besides [+], [–], ¼, MF/∞/MENTS and DISP.
Displaying Nine Images

The following operation lets you simultaneously view nine images on the same screen. This capability is especially useful when playing back to the screen of a connected TV, and can be used to display a catalog of products, etc.

1. Slide the Function Switch to PLAY.
2. Press MENU.
3. Select “9 Multi”.
   - On the advanced menu, select “View” → “9 Multi”.
   - The first image of the set is the image that was on the screen when you performed step 2 of this operation. The other images are those that sequentially follow the first one.

4. Use [+] and [–] to scroll through images stored in memory.
   - To view a particular image in normal size, press DISP. This causes the $\text{acak}$ mark to appear in the upper left corner of the monitor screen. To produce an enlarged view of an image, use [+] and [–] to move the $\text{acak}$ mark to the image you want and then press the shutter button.

5. After you are finished, press any button besides [+] or [–] or DISP return to the normal single-image display.
IMPORTANT!

Auto Power Off (page E-41) is disabled whenever Slide Show is being used. This means you should not leave Slide Show running when using batteries to power the camera. Doing so can rundown batteries. Be sure to stop Slide Show and turn off the camera after you are finished.

1. Slide the Function Switch to PLAY.

2. Press MENU.

3. Select “Slide Show”.
   • On the advanced menu, select “View” → “Slide Show”.

4. To stop Slide Show, press any button besides MENU.
   • Pressing MENU while a Slide Show is in progress displays a screen that lets you change the interval within the range of 3 to 30 seconds.
   • Note that all buttons are disabled while an image change is in progress. Wait until an image is stopped on the monitor screen before performing a button operation, or hold down the button until the image stops.
   • Images copied from another digital camera or a computer may take longer time to appear.
Screen Saver

The screen saver function automatically activates Slide Show (which automatically scrolls through images) whenever you do not perform any operation for about five minutes in the Playback Mode. This protects the camera’s monitor screen and the screen of a connected TV against “burn in” of a static image that is left displayed too long.

IMPORTANT!

- The screen saver is enabled only when the camera is being powered by its optional AC adaptor. If you do not perform any operation for five minutes under battery power, camera power automatically turns off (Auto Power Off).
- The screen saver displays protected images only. The screen saver is disabled if there are no protected images in memory.
- Photo Loader will not send images between the camera and a personal computer while the screen saver is turned on. Make sure you turn off the screen saver before trying to perform any image transfer operation. Note that the screen saver is turned on when you purchase the camera.

1. Slide the Function Switch to PLAY.

2. Press MENU.

   - “Tools” appears on the advanced menu only.
   - To turn off the screen saver, perform the above procedure and select “Off”.
   - The screen saver activates if you do not perform any operation for about five minutes in the Playback Mode.
   - Press any key to exit the screen saver.
   - When changing between images, the screen saver uses the interval that is specified for Slide Show (page E-84).
Using the Playback Menus

The playback menus provide you with control over the display format and DPOF settings, image delete and save operations, and other settings. Each playback menu has two formats: a basic menu and an advanced menu. Press DISP to toggle between the basic menu and advanced menu.

Playback Menus

See “Menu Screens” on page E-32 for information about how to use menus. Basic menu items are indicated by \text{BASIC}.

<table>
<thead>
<tr>
<th>View</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\text{Zoom}</td>
<td>Enlarges the image on the monitor screen.</td>
</tr>
<tr>
<td>\text{9 Multi}</td>
<td>Displays nine images on the monitor screen.</td>
</tr>
<tr>
<td>\text{Slide Show}</td>
<td>Automatically scrolls through the images one-by-one.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tools</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protect</td>
<td>Use this item to protect images against deletion.</td>
</tr>
<tr>
<td>\text{Select}</td>
<td>Protects a single specific image.</td>
</tr>
<tr>
<td>\text{Folder}</td>
<td>Protects all images in a specific folder.</td>
</tr>
<tr>
<td>\text{All}</td>
<td>Protects all images.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tools</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DPOF</td>
<td>Use this item to specify images for printing on a</td>
</tr>
<tr>
<td>\text{BASIC}</td>
<td>DPOF printer.</td>
</tr>
<tr>
<td>\text{Select}</td>
<td>Prints a single specific image.</td>
</tr>
<tr>
<td>\text{Folder}</td>
<td>Prints a specific number of copies of all images in a specific folder.</td>
</tr>
<tr>
<td>\text{All}</td>
<td>Prints a specific number of copies of all images.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tools</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Screen Saver</td>
<td>This item turns the screen save on and off.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tools</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select</td>
<td>Deletes a single specific image.</td>
</tr>
<tr>
<td>\text{BASIC}</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tools</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Folder</td>
<td>Deletes all unprotected images in a specific folder.</td>
</tr>
<tr>
<td>\text{BASIC}</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tools</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Deletes all unprotected images.</td>
</tr>
<tr>
<td>\text{BASIC}</td>
<td></td>
</tr>
<tr>
<td>Set Up</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Card Browser</strong> BASIC</td>
<td>Use this item to select the card browser file type. Off/ Type1 / Type2 / Type3 / Type4</td>
</tr>
<tr>
<td><strong>Format</strong> BASIC</td>
<td>Select this item to format a memory card.</td>
</tr>
<tr>
<td><strong>Date</strong> BASIC</td>
<td>Use this item to specify the format of the date that appears in the monitor screen, and to adjust the date setting. Style(Year/Month/Day / Day/Month/Year / Month/Day/Year) / Adjust</td>
</tr>
<tr>
<td><strong>Video Out</strong> BASIC</td>
<td>This item can be used to specify the format of the video output signal. NTSC : Video format in the United States and Japan PAL : Video format in Europe and other areas</td>
</tr>
<tr>
<td><strong>Language</strong> BASIC</td>
<td>This setting lets you select either English or Japanese as the display language.</td>
</tr>
<tr>
<td><strong>Beep</strong> BASIC</td>
<td>Use this item to turn the key input confirmation tone on and off.</td>
</tr>
</tbody>
</table>
FOLDER TYPES

Memory Card Folder Precautions

The camera automatically creates folders (directories) on the memory card and assigns them names based on dates (month and day). Any image you record is automatically stored into the folder that corresponds to the date it is recorded.

- Up to 900 folders can be created on a single card. The following shows a typical folder name.

100_0719

  Serial number  Day

  Month

- Up to 250 image files can be stored in each folder. The following shows a typical file name.

11070026.JPG

  Month  Day  Extension (JPG or AVI)

  Serial number

- When you try to save the 251st image to a folder, the camera automatically creates a new folder and store the image there.
- The above maximum number of files and folders are absolute maximums. The actual number of folders and files may be less due to memory card capacity and the size of each image.
- Panorama images are divided into multiple images and stored on the memory card.
- See “USING CompactFlash CARDS WITH YOUR COMPUTER” on page E-103 for information about how files and folders are organized.
- If there are more than 250 image files in a folder (due to copying from another digital camera or a computer), only the first 250 (in name sequence) can be played back.
Selecting a Folder for Playback

1. Slide the Function Switch to PLAY.

2. Press \[\text{Play Button}\].

3. Use \[+\] and \[-\] to select the folder you want to select for playback.

4. Press the shutter button to playback the first image in the folder.
Use the following operations when you want to protect images against accidental deletion. A protected image cannot be deleted until it is unprotected. You can protect and unprotect a single specific image, all the image in a particular folder, or all images currently on the memory card.

**IMPORTANT!**
Formatting a memory card (page E-36) deletes all images on the card, even if some or all of the images are protected.

### Protecting and Unprotecting a Single Image

1. Slide the Function Switch to PLAY.
2. Press MENU.
3. Select “Tools” → “Protect” → “Select”.
   - “Tools” appears on the advanced menu only.
4. Select the image you want to protect.
   - Selected images are indicated by
   - Repeat step 4 to select other images if you want.
5. After all the images you want to protect are selected, press DISP to protect them.
Protecting and Unprotecting Folders

1. Slide the Function Switch to PLAY.

2. Press 

3. Use [+][–] to select the folder you want to protect.

4. Press the shutter button.

5. Press MENU.

6. Select “Tools” → “Protect” → “Folder”.
   • “Tools” appears on the advanced menu only.

7. Select “Protect” or “Unprotect”.
   • The indicator that is shown in the upper left corner of the images when image information is turned on indicates they are protected.
   • The indicator does not appear when images are not protected.

Protecting and Unprotecting All Images on a Memory Card

1. Perform steps 1 through 2 under “Protecting and Unprotecting a Single Image”.

2. Select “Tools” → “Protect” → “All”.
   • “Tools” appears on the advanced menu only.

3. Select “Protect” or “Unprotect”.
   • The indicator that is shown in the upper left corner of the images when image information is turned on indicates they are protected.
   • The indicator does not appear when images are not protected.
DELETING IMAGES

Use the following operations when you want to delete images. You can delete a single specific image, all the images in a particular folder or all images currently on the memory card.

IMPORTANT!

- Image deletion cannot be undone. Before deleting an image, make sure you no longer need it or you have a back-up copy saved on your computer, on diskette, or on some other medium.
- Be especially careful with “Deleting All Unprotected Images” operation, which deletes all unprotected images in memory.
- A protected image cannot be deleted. See “IMAGE PROTECTION” on page E-90 for details on protecting and unprotecting images.

Deleting a Single Image

1. Slide the Function Switch to PLAY.
2. Press MENU.
3. Select “Delete” → “Select”.
4. Select the image you want to delete.

- Protected images are not displayed.
- Selected images are indicated by 🔐.
- Note that the first time you display an image its 🔐 icon is turned on.
- Repeat step 4 to select other images if you want.
5. After all the images you want to delete are selected, press DISP to delete them.

6. Select “Yes” to delete the contents of the folder, or “No” to abort the delete operation without deleting anything.
   • Deleting a panorama deletes all of the images that make it up as well.

**NOTE**

The camera does not maintain open spaces in its memory. Deleting an images causes all images following the deleted image to be shifted up.

---

**Deleting All the Images in a Folder**

1. Slide the Function Switch to PLAY.

2. Press \( \text{ } \)

3. Use [+ ] and [– ] to select the folder you want to delete.

4. Press the shutter button.

5. Press MENU.

6. Select “Delete” → “Folder”.

DELETING IMAGES

7. Select “Yes” to delete the contents of the folder, or “No” to abort the delete operation without deleting anything.
   • When the above procedure is performed while there are protected images in memory, the first of the protected images appears on the monitor screen after the unprotected images are deleted.

Deleting All Unprotected Images

1. Slide the Function Switch to PLAY.

2. Press MENU.

3. Select “Delete” → “All”.

4. Select “Yes” to delete all unprotected images, or “No” to abort the delete operation without deleting anything.
   • When the above procedure is performed while there are protected images in memory, the protected image appears on the monitor screen after the unprotected images are deleted.
The letters “DPOF” stand for “Digital Print Order Format”, which is a format for recording on a memory card or other medium which digital camera images should be printed and how many copies of the image should be printed. DPOF makes it possible for a DPOF compatible printer or professional print service to print images from a memory card without having to specify individual file names.

1. Slide the function switch to PLAY.

2. Press MENU.

3. Select “DPOF” → “Select”.
   • On the advanced menu, select “Tools” → “DPOF”.

4. Use [+] and [–] to select the image you want to print.

5. Press the shutter button.
   • Selected images are indicated by .

The letters “DPOF” stand for “Digital Print Order Format”, which is a format for recording on a memory card or other medium which digital camera images should be printed and how many copies of the image should be printed. DPOF makes it possible for a DPOF compatible printer or professional print service to print images from a memory card without having to specify individual file names.
6. Use [+] and [–] to specify the number of copies you want to print, and then press the shutter button.
   - If you want to specify more images for printing, repeat steps 4 through 6.
   - If you change your mind about printing an image, press [–] to clear its mark.

7. After you are finished, press DISP button to exit the image specification procedure.

<table>
<thead>
<tr>
<th>Printing All the Images in a Folder</th>
</tr>
</thead>
</table>

1. Slide the function switch to PLAY.

2. Press  

3. Use [+] and [–] to select the folder you want to print.

4. Press the shutter button.

5. Press MENU.

6. Select “DPOF” → “Folder” → “Set print order”.
   - On the advanced menu, select “Tools” → “DPOF” → “Folder” → “Set print order”.
   - To cancel current print settings, select “Cancel print order”.

7. Press the shutter button.
   - If you selected “Cancel print order” in step 4, pressing the shutter button returns to the playback screen.
8. Use [+ ] and [– ] to specify the number of copies of each image you want to print.

9. After you are finished, press the shutter button to exit the image specification procedure.

1. Slide the function switch to PLAY.

2. Press MENU.

3. Select “DPOF” → “All” → “Set print order”.
   - On the advanced menu, select “Tools” → “DPOF” → “All” → “Set print order”.
   - To cancel current print settings, select “Cancel print order”.

4. Press the shutter button.
   - If you selected “Cancel print order” in step 3, pressing the shutter button returns to the playback screen.

5. Use [+ ] and [– ] to specify the number of copies of each image you want to print.

6. After you are finished, press the shutter button to exit the image specification procedure.
This camera is equipped with a VIDEO OUT terminal for connection to a television or video deck, and a DIGITAL terminal and USB port for connection to a computer or other equipment.

IMPORTANT!

• Be sure to turn off both the camera and other equipment before making any connections.
• Check the documentation that comes with your other equipment for information you may need to know when making connections.
• Leaving the same image displayed on a television or computer display screen for very long periods can cause the image to be “burned in” on the screen. When this happens, a faint after-image remains on the screen, even after you disconnect the camera. To avoid this, you should not leave the same image displayed on such a screen for very long periods.
• This camera does not support cable transfer of data with other CASIO digital cameras.

• When connecting a plug to the DIGITAL terminal, make sure the cord is facing in the direction of the VIDEO OUT terminal as shown in the illustration. Otherwise, you will not be able to fully insert the plug into the terminal.
Images being displayed on the camera’s monitor screen, whether for recording or playback can also be displayed on the screen of a connected television.

**1. Connect one end of the video cable to the camera and the other end to the television.**

**2. Set up the television for video input.**
   - See the documentation that comes with the television for information about how to do this.

**3. The connection procedure is the same for both recording and playback.**

**IMPORTANT!**
- A television must have a video input terminal like the one shown in the illustration to connect to this camera.
- Battery capacity (page E-40) and other displays that normally appear on the camera’s monitor screen are also displayed on the television screen.
- The monitor screen goes blank as soon as you connect the video cable to the camera.

**Selecting the Video Output Signal Mode**

You can select either of two common video output modes: NTSC or PAL.

The video system you should use depends on the country where you plan to use the output signal. In the United States or Japan, for example, you should use NTSC, but in Europe you need to use PAL.

Check with your local video or TV retailer if you are unsure about which video mode you should use in your country.

**1. Press MENU.**

**2. Select “Set Up” → “Video Out”.**

**3. Select the video mode you want to use.**
Connecting to a Computer

The following accessories are included with the camera to make it easy for you to connect to a computer to transfer and manage your images.
- USB cable
- USB driver software (on CD-ROM)
- Data Transfer Cable
- Photo Loader application (on CD-ROM)

USB Port Connections

The camera’s USB port and accessories make it easy to connect to a computer equipped with a USB port. First install the USB driver software that comes bundled with the camera on your computer, and then use its special USB cable to make the connection. Once connected, you can view images on your computer’s display and store images on its hard disk.
- See the separate installation manual for information about how to install the driver software on your computer.

System Requirements

<table>
<thead>
<tr>
<th>Windows</th>
<th>Macintosh</th>
</tr>
</thead>
<tbody>
<tr>
<td>• IBM PC/AT or compatible computer pre-installed with Windows 98</td>
<td>• Mac OS 8.5 or higher, Mac OS 8.1 with USB system extentions (iMac update 1.0 is required)</td>
</tr>
<tr>
<td>• 486 or higher CPU (Pentium recommended)</td>
<td>• Power PC G3</td>
</tr>
<tr>
<td>• CD-ROM drive (for installation)</td>
<td>• CD-ROM drive (for installation)</td>
</tr>
<tr>
<td>• Keyboard and mouse or equivalent input device</td>
<td>• Keyboard and mouse or equivalent input device</td>
</tr>
<tr>
<td>• Available USB port</td>
<td>• Available USB port</td>
</tr>
</tbody>
</table>

* Proper operation is not guaranteed under the following conditions.
  - A computer that has been updated from Windows 95 to Windows 98
  - This USB driver does not run under Windows 3.1, Windows 95 or Windows NT.
* The USB driver may not run correctly under certain hardware configurations.
USB Port Connection

**IMPORTANT!**
- Plug the USB connectors into the ports as far as they will go. Incorrect connection can result in improper operation.
- Turn off the camera before connecting the USB cable to it.
- The camera is not supplied power by the USB cable. Be sure to use the optional AC adaptor to power the camera whenever using a USB cable connection.
- Never disconnect the USB cable while a data communication operation is in progress. Doing so can corrupt memory data.

Data Transfer Cable Connection

You can use the Data Transfer Cable to connect to your personal computer through the camera’s DIGITAL terminal. Then you save images on your computer’s hard disk using the Photo Loader application.

- See the separate installation manual for information about how to install Photo Loader on your computer.

**Windows 95, 98, NT Workstation 4.0**

The Data Transfer Cable can be connected to an IBM PC/AT or compatible that is equipped with a D-Sub9 RS-232C terminal.
Macintosh
Connection of the Data Transfer Cable and operation of the Photo Loader application is not supported on an Apple Macintosh.

IMPORTANT!

• See the documentation that comes with Photo Loader for information about system requirements.
• Be sure to turn off the camera, computer, and all peripherals (monitor, disk driver, etc.) connected to the computer before connecting the digital camera with the Data Transfer Cable.
• Never connect or disconnect the cable while Photo Loader is running. Doing so can cause problems with program execution, can corrupt data, and can damage the camera and your computer.
• Data transfer while camera batteries are low can result in sudden shutdown of the camera. Because of this, use of the optional AC adaptor is recommended whenever performing data communication with the camera.
• This camera does not support data communication with any of the optionally available CASIO PC link software applications: LK-1, LK-1A, LK-10V, LK-11W, LK-2, LK-2A, LK-2V, LK-21.
Setting Up to Access CompactFlash Card Contents From Your Computer

You can use any of the three methods described below to access the contents of a memory card with your computer. You can use the Photo Loader software to save images on the memory card to your computer.

CompactFlash Memory Card Slot

If your computer has a CompactFlash Memory Card Slot, insert the camera’s memory card into the slot.

PC Card Slot

In this case you need an optionally available CASIO CA-10 PC Card Adaptor. See the instructions that come with the PC Card Adaptor and the documentation that comes with your computer for details on using this type of configuration.

Other Desktop Computer Configurations

Some desktop computers require a separately available PC card reader/writer and the optionally available CASIO CA-10 PC Card Adaptor to read memory card contents. See the instructions that come with the PC card reader/writer and the PC Card Adaptor for details on using this type of configuration.
Memory Card Data

Images recorded with this camera and other data is stored on the memory card using DCF (Design rule for Camera File system) protocol. DCF protocol is designed to make it easier to exchange image and other data between digital cameras and other devices.

DCF Protocol

DCF devices (digital cameras, printers, etc.) can exchange images with each other. DCF protocol defines the format for image files data and the directory structure for the memory card, so images can be viewed using another manufacturer’s DCF camera or printed on a DCF printer.

In addition to support for the DCF protocol, your CASIO digital camera also shows dates in image folder names and image file names, which helps to make data management easier.

CompactFlash Card Directory Tree
Folder and File Contents

- Parent Folder
  Contents: All files used by the digital camera

- Card Browser Main File
  Contents: Template for card browser, which is used for viewing image previews with a web browser

- Management File
  Contents: Information about folder management, image sequence, etc.

- DPOF File Folder
  Contents: DPOF files

- DPOF File
  Contents: Printer data

- Card Browser Folder
  Contents: Files used by the card browser

- Card Browser File
  Contents: Data used by the card browser

- Main Image Folder
  Contents: Image file recorded by the camera

- Main Image File
  Contents: Still image file recorded by the camera

- Main Movie File
  Contents: Movie file recorded by the camera

- Preview Folder
  Contents: Preview images

- Preview Image File
  Contents: Preview images of still image and movie files used for temporary playback and card browser previews

Image Files Supported by the Camera

- Image files recorded with the CASIO QV-8000SX Digital Camera
- JPEG files stored using Photo Loader
  (1280 x 960 pixels or 640 x 480 pixels JPEG file)
- DCF protocol image files
- JPEG files stored using QV-LINK (1280 x 960 pixel and 640 x 480 pixel JPEG files)
Personal Computer

- This camera uses management files to manage the sequence and attributes of image files. Because of this, adding files, deleting files, changing management file contents, or changing file sequence and attributes with your computer can cause panorama images to become ungrouped. It can also result in slower image scrolling on the camera.
- When transferring CompactFlash card contents to a hard disk, floppy diskette, MO disk, or other external storage, keep everything in the DCIM folder together. Changing the name of the DCIM folder to a date is a good way to keep track of your images. However, be sure to change the name of this folder back to DCIM if you ever copy it back to the memory card for playback on the camera. This camera does not recognize any folder name besides DCIM.
- The above is also true about the names of folders inside the DCIM folder. These folders must be returned to the names assigned to them by the camera whenever you copy the DCIM folder back to the memory card for playback on the camera.
- Never delete or modify the QVS file in any way.
- We also strongly recommend that after transferring data from a CompactFlash card to other external storage that you re-format the card and delete its contents before using it to record more images.

Card Browser

Card Browser makes it possible to use a browser application to view images recorded with the QV-8000SX.
- The HTML file generated by this camera is best viewed using Microsoft Internet Explorer 4.01 or later, or Netscape Communicator 4.5 or later. It cannot be viewed using Photo Loader.
- QuickTime 3 is required to play back AVI movie files.

1. Press MENU.

2. Select “Set Up” → “Card Browser”.

![Card Browser Screen]

E-106
3. Specify the format.

There are four Card Browser formats.

Type1......... This is a powerful format that provides detailed information about each image and also includes a Slide Show feature.

Type2......... This format is a viewer with a Slide Show feature.

Type3......... This format shows information about each image. You should be able to use it with any browser, regardless of version.

Type4......... This format provides basic image viewing. Since it is the simplest option, you should be able to use it with just about any browser, regardless of version.

### IMPORTANT!

- Note that the Type1 and Type3 formats use Java Script, so their use requires Microsoft Internet Explorer 4.01 or later, or Netscape Communicator 4.5 or later.
- In the case of Type1 and Type3, Slide Show displays 640 x 480 pixels and 1280 x 960 pixels image in the same size, so image details may appear relatively coarse.

<table>
<thead>
<tr>
<th>Card Browser Format</th>
<th>Type1</th>
<th>Type2</th>
<th>Type3</th>
<th>Type4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Screen</td>
<td>○</td>
<td>○</td>
<td>×</td>
<td>×</td>
</tr>
<tr>
<td>Index Screen</td>
<td>○</td>
<td>○</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Actual Size (in pixels)</td>
<td>×</td>
<td>○</td>
<td>×</td>
<td>○</td>
</tr>
<tr>
<td>VGA Size</td>
<td>○</td>
<td>×</td>
<td>○</td>
<td>×</td>
</tr>
<tr>
<td>SXGA Size</td>
<td>○</td>
<td>×</td>
<td>○</td>
<td>×</td>
</tr>
<tr>
<td>Image Scrolling</td>
<td>○</td>
<td>×</td>
<td>○</td>
<td>×</td>
</tr>
<tr>
<td>Slide Show</td>
<td>○</td>
<td>×</td>
<td>○</td>
<td>×</td>
</tr>
<tr>
<td>Full Screen</td>
<td>○</td>
<td>×</td>
<td>○</td>
<td>×</td>
</tr>
<tr>
<td>Movie (AVI) Play</td>
<td>Endless</td>
<td>One Time</td>
<td>Endless</td>
<td>One Time</td>
</tr>
</tbody>
</table>
• The index screen uses the contents of the Preview Folder (page E-104). Images copied from another digital camera or a computer may not have preview images, and so they do not appear in the index screen. If this happens, scroll through the images on the monitor screen until the copied images appear. At this time, the camera automatically generates a preview image, which will now appear on the Card Browser index screen.

• Turning on Card Browser causes an HTML file to be generated whenever you turn off camera power.
• Selecting “Off” in step 3 of the above procedure turns off Card Browser.
• Creation of an HTML file causes an INDEX.HTM file and other files to be added to the DCIM folder.

IMPORTANT!
• Though the camera’s monitor screen goes blank when you turn off power, the operation lamp continues to flash for some time as the camera internally generates a Card Browser file (when Card Browser is turned on). Performing any of the operations while the operation lamp is flashing not only stops generation of the Card Browser file, it can also result in corruption of the image data on the CompactFlash Card. Note that a Card Browser file may be corrupted if batteries are low or if the CompactFlash Card becomes full during file generation.

• If the CompactFlash card in the camera has a large number of files on it, it may take quite a bit of time for the camera to generate the required HTML files and actually turn off after you slide the POWER switch towards OFF. Because of this, we recommend that you normally leave Card Browser turned off, except when you actually want to generate HTML files.
• This camera generates a Card Browser file whenever you turn off power. When the card in the camera contains a large number of files, it may take some time for the file generation operation to be performed. You can turn off the Card Browser feature if you do not want a file generated each time you turn off camera power.
• If you perform a timer operation while Card Browser is turned on, files are not generated until the number of shots specified for the timer’s SHOTS setting are recorded. If you want to generate files for images recorded by a timer operation that is not yet complete, turn the camera off, wait for the files to be generated, and then turn the camera back on again. Note, however, that this also cancels the ongoing timer operation.
How to use the HTML file

Viewing HTML File Contents

Load the CompactFlash card into a card slot of your computer (page E-103). Now drop the INDEX.HTM file (in the DCIM folder) onto your Web browser to display a list of all images contained on the CompactFlash card. For information about importing data from a memory card, see “Setting Up to Access CompactFlash Card Contents from Your Computer” (E-103) and “Connecting to a Computer” (E-100).

Clicking on a folder name displays the following data about the images contained in the folder.

- File name
- Image
- File name

Clicking on a folder name displays the following data about the images contained in the folder.

- File size (KB)
- Resolution (pixels)
- Quality
- Recording mode
- AE
- Light metering
- Shutter speed
- Aperture stop
- Exposure comp
- Focusing mode
- Flash mode
- Sharpness
- Saturation
- Contrast
- White balance
- Digital zoom
- Date
- Model

Click Index to return to the image list.
### Function Descriptions

<table>
<thead>
<tr>
<th>Index Screen</th>
<th>When the computer accesses the memory card, it opens the INDEX.HTM file in the DCIM folder and displays an index of folders, with the newest one first. Clicking the INDEX button under a folder name in the left frame displays an index of all the images in the folder. Clicking the INDEX button under ALL Folder displays an index of all the files in all folders.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Screen</td>
<td>Clicking the DATA button under a folder name in the left frame displays the images in the folder and their recording information.</td>
</tr>
<tr>
<td>Actual Size (in pixels)</td>
<td>Accessing the memory card on your computer and clicking the INDEX.HTM in the DCIM folder displays 320 x 240-pixel size images in the newest folder. Clicking directly on the image changes SXGA size or VGA size, whichever was the recorded size of the image. This function is available with the Type2 and Type4 formats only.</td>
</tr>
<tr>
<td>VGA Size</td>
<td>Clicking directly on an image in the index or data screen displays its VGA size (CHILD PAGE) image.</td>
</tr>
<tr>
<td>SXGA Size</td>
<td>Clicking directly on a VGA size image displays its SXGA (IMAGE DISPLAY) image. The SXGA image is always displayed, regardless of the recorded size of the image.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Image Scrolling</th>
<th>Clicking the arrows above a VGA size image scrolls forward and back through the images. Clicking directly on an SXGA size image advances to the next image. You can select page scrolling for a particular folder or all folders. AVI files are not displayed.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slide Show</td>
<td>Images in a specific folder or all folders opened to the maximum window size to match the monitor being used. AUTO or MANUAL can be selected as the image change type. AVI files are not displayed.</td>
</tr>
<tr>
<td>Full Screen</td>
<td>Selecting AUTO for the slide show causes images in a specific folder or all folders opened to the maximum window size to match the monitor being used. Images are changed at an interval of about five seconds.</td>
</tr>
<tr>
<td>Movie (AVI) Play</td>
<td>AVI movie files can be played back on the screen. Playback image size is the same as the record image size. Endless playback is performed with the Type1 or Type3 format, while Type2 and Type4 plays the movie once and then stops.</td>
</tr>
</tbody>
</table>
Saving an HTML File

- You can use the Photo Loader application to easily save the images in the HTML file to a computer. See the documentation that comes with Photo Loader for details.
- Before using the CompactFlash card again (after storing its images on other media), delete all its current files or reformat the card.
## TROUBLESHOOTING

<table>
<thead>
<tr>
<th>Power Supply</th>
<th>Symptom</th>
<th>Probable Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>2. Dead batteries</td>
<td>2. Replace all four batteries with a set of new ones (page E-38).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Wrong AC adaptor</td>
<td>3. Use only recommended AC adaptor.</td>
</tr>
<tr>
<td>Sudden power failure</td>
<td>1. Auto Power Off</td>
<td></td>
<td>1. Turn power back on.</td>
</tr>
<tr>
<td></td>
<td>2. Low battery power</td>
<td></td>
<td>2. Replace all four batteries with a set of new ones (page E-38).</td>
</tr>
<tr>
<td></td>
<td>3. Use of manganese batteries.</td>
<td></td>
<td>3. Replace manganese batteries with alkaline, lithium or Ni-MH batteries.</td>
</tr>
<tr>
<td>“🔋” indicator on LCD</td>
<td>Batteries are about to go dead.</td>
<td></td>
<td>Replace all four batteries with a set of new ones (page E-38).</td>
</tr>
<tr>
<td>No recording when shutter button is pressed</td>
<td>1. Function Switch set to PLAY.</td>
<td></td>
<td>1. Set Function Switch to REC.</td>
</tr>
<tr>
<td></td>
<td>2. Flash unit is charging.</td>
<td></td>
<td>2. Wait until flash unit charging is finished.</td>
</tr>
<tr>
<td></td>
<td>3. The message “MEMORY FULL” is on the monitor screen.</td>
<td></td>
<td>3. Delete images you no longer need from camera memory.</td>
</tr>
<tr>
<td></td>
<td>4. Insufficient memory card capacity or no memory card loaded in camera.</td>
<td></td>
<td>4. Load a memory card.</td>
</tr>
<tr>
<td>Recording</td>
<td>Auto Focus cannot focus the image.</td>
<td></td>
<td>1. Clean off the lens.</td>
</tr>
<tr>
<td></td>
<td>1. Lens is dirty.</td>
<td></td>
<td>2. Aim the camera so the object you want to focus is in inside the focus frame.</td>
</tr>
<tr>
<td></td>
<td>2. The object you want to focus is not in the focus frame.</td>
<td></td>
<td>3. Switch to the Manual Mode and focus manually.</td>
</tr>
<tr>
<td></td>
<td>3. Conditions make it impossible to obtain proper focus.</td>
<td></td>
<td>4. Use a tripod to steady the camera.</td>
</tr>
<tr>
<td></td>
<td>4. Camera is unsteady or shaking.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Symptom</td>
<td>Probable Cause</td>
<td>Action</td>
<td></td>
</tr>
<tr>
<td>---------</td>
<td>----------------</td>
<td>--------</td>
<td></td>
</tr>
<tr>
<td>The recorded image is out of focus.</td>
<td>The focus setting is not correct.</td>
<td>Make sure the subject you want to focus is within the Auto Focus Frame when you record the image.</td>
<td></td>
</tr>
<tr>
<td>Power failure during self-timer operation</td>
<td>Low battery power</td>
<td>Replace all four batteries with a set of new ones (page E-38).</td>
<td></td>
</tr>
</tbody>
</table>
| Monitor screen image is out of focus. | 1. Failure to focus the image while the camera is in the Manual Mode.  
2. Camera is in the Macro Mode.  
3. Camera is in the Auto Focus Mode while the subject is too close. | 1. Focus the image before recording it.  
2. Use the Auto Focus Mode for scenery and group shots.  
3. Use the Macro Mode when the subject is too close for Auto Focus. |
| Poor color and brightness when indoors | Indoor fluorescent lighting | Shoot under incandescent or other non-fluorescent lighting (page E-48). |
| Cannot perform movie recording. | 1. Movie Record Mode is not selected.  
2. Insufficient camera memory capacity. | 1. Select the Movie Record Mode (page E-61).  
2. Delete images you no longer need from camera memory. |
| Recorded image is not saved. | 1. Loss of power before image is stored in memory  
2. Memory card cover was opened before the image was fully saved. | 1. Replace all four batteries with a set of new ones (page E-38).  
2. Never open the memory card cover until the image is fully saved. |
| Colors of recorded image are different from those on the display when image was composed. | 1. Reflection from sunlight or light from another source  
2. Image quality setting | 1. Reorient the camera so that light is not shining directly into lens.  
2. Use the Recording Menu to change to a higher image quality for recording. |
### TROUBLESHOOTING

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Probable Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>No +/- button operation during nine-page display</td>
<td>Button operation during page change</td>
<td>Wait until an image is on the monitor screen before performing a button operation.</td>
</tr>
<tr>
<td>Cannot find an image.</td>
<td>1. Memory card images recording using a camera that does not support DCF.</td>
<td>1. The file management systems of cameras that do not support DCF are different from the one used by this camera. This camera cannot read cards recorded with such cameras.</td>
</tr>
<tr>
<td></td>
<td>2. Management files required to display images cannot be created.</td>
<td>2. Make more room available on the memory card by deleting some of its images or other data.</td>
</tr>
<tr>
<td>Playback</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Camera is connected to a TV, but LCD monitor con-</td>
<td>1. Incorrect camera-TV connection</td>
<td>1. Connect correctly using the video cable (page E-98).</td>
</tr>
<tr>
<td>tents do not appear on TV screen.</td>
<td>2. Wrong TV set up</td>
<td>2. Set up the TV correctly.</td>
</tr>
<tr>
<td></td>
<td>3. Wrong video mode is selected.</td>
<td>3. Change the video mode.</td>
</tr>
<tr>
<td>Images cannot be displayed when downloaded back</td>
<td>The images were on a memory card when they were opened on the computer for editing and then resaved back to the memory card.</td>
<td>Use the Photo Loader application to download edited images back to the camera.</td>
</tr>
<tr>
<td>the camera from a computer.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Deletion</td>
<td>All images are protected.</td>
<td>Unprotect the images you want to delete (page E-90).</td>
</tr>
</tbody>
</table>
### TROUBLESHOOTING

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Probable Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Other</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cannot select items in the Playback Menu.</td>
<td>Some functions are not available for playback of certain types of images.</td>
<td>Select a different function or change to the Record Mode.</td>
</tr>
</tbody>
</table>
| No buttons or switches operate. | • Malfunction due to static electrical charge or strong impact.  
• Camera is connected to a computer. | Remove batteries and disconnect the AC adaptor if you are using one. Restore power and turn the camera on. If this does not work, contact your dealer or an authorized CASIO service provider. |
| Slide Show starts even though it is not selected. | Activation of the screen saver. | Turn off screen saver (page E-85). |
| Nothing appears on the monitor screen. | 1. The camera is in the Sleep state.  
2. Communication over the USB cable is in progress. | 1. Exit the Sleep state.  
2. After the communication operation over the USB cable is complete unplug the USB cable from the camera. |
## MESSAGES

<table>
<thead>
<tr>
<th>Can’t play PANORAMA</th>
<th>This message appears when there is not enough memory to perform panorama recording. Delete some images from the memory card to make room for the new image.</th>
</tr>
</thead>
<tbody>
<tr>
<td>CF ERROR</td>
<td>Perform the following procedure whenever a memory card starts to behave abnormally.</td>
</tr>
<tr>
<td>You must format the CompactFlash card before using it with this camera. FORMAT → MENU</td>
<td>Important! The procedure described below deletes all images stored in the memory card. Make sure all of your important images are backed up onto a computer hard disk or other storage medium before performing this procedure.</td>
</tr>
<tr>
<td></td>
<td><strong>To reformat a memory card</strong></td>
</tr>
<tr>
<td></td>
<td>1. Connect the AC adaptor to the camera and switch to AC power or load a new set of batteries into the camera.</td>
</tr>
<tr>
<td></td>
<td>• Power failure while a format operation is being performed aborts the reformat operation.</td>
</tr>
<tr>
<td></td>
<td>2. Press MENU.</td>
</tr>
<tr>
<td>MEMORY FULL</td>
<td>Not enough memory for recording in the current quality mode. Change to another quality mode, or delete some images from the memory card (pages E-53, 92).</td>
</tr>
<tr>
<td>Change quality or delete unneeded images.</td>
<td></td>
</tr>
<tr>
<td>MEMORY FULL</td>
<td>• Not enough memory for further recording. Delete some images from memory card (page E-92).</td>
</tr>
<tr>
<td>Delete unneeded images.</td>
<td>• DCIM folder or other file (page E-104) cannot be created due to insufficient memory when downloading data from a computer to the memory card. Use your computer to delete unneeded images to free up memory card space for the images you are downloading. You could also press the MENU button and format the memory card in the camera, but doing so deletes all image files currently stored on the memory card.</td>
</tr>
<tr>
<td>NO FORMAT</td>
<td>The memory card is not formatted. Format the memory card before trying to use it (page E-36).</td>
</tr>
<tr>
<td></td>
<td>There is no memory card installed in the camera.</td>
</tr>
<tr>
<td>MESSAGE</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>RECORD ERROR</td>
<td>This message appears when the image you are trying to record cannot be compressed for some reason. Try changing the angle of the camera to the subject.</td>
</tr>
<tr>
<td>REPLACE BATTERY!</td>
<td>Battery power is low. Camera power turns off automatically shortly after this message appears.</td>
</tr>
<tr>
<td>There are no images on this memory card!</td>
<td>No images are stored in memory card.</td>
</tr>
<tr>
<td>This camera cannot display the image you selected!</td>
<td>The JPEG image file you are trying to display is either corrupted or is a format that is not compatible with this camera.</td>
</tr>
<tr>
<td>Timer operation cancelled.</td>
<td>Timer recording was cancelled. To perform timer recording, make all necessary timer settings again.</td>
</tr>
</tbody>
</table>
Description ......................... Digital camera
Model ............................. QV-8000SX

Recorded Image
File Format ........................ Still images (including panoramas):
JPEG (Exif. Ver. 2.1), DCF standard (design rule for camera file system),
DPOF compatible, Movies: AVI

Recording Medium .......... CompactFlash card

Recorded Image Size .......... 1280 x 960 pixels, 640 x 480 pixels

Standard Memory Capacity, Number of Image Files,
Computer Output Image Size

<table>
<thead>
<tr>
<th>Static</th>
<th>1280 x 960</th>
<th>FINE</th>
<th>88/13 sets (500KB/image)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>NORMAL</td>
<td>122/16 sets (350KB/image)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ECONOMY</td>
<td>206/29 sets (200KB/image)</td>
</tr>
<tr>
<td>640 x 480</td>
<td>FINE</td>
<td>268/39 sets (150KB/image)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>NORMAL</td>
<td>327/48 sets (120KB/image)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ECONOMY</td>
<td>418/63 sets (90KB/image)</td>
</tr>
</tbody>
</table>

Movie: File Format AVI

Approximate Total: 155 seconds/25 seconds (300KB/second)
• The maximum length of a single movie is 10 seconds.

* When using 48MB/8MB CF card.

Image Deletion ..................... Single image; all images in a folder; all images in memory (with image protection)

Imaging Element ................... 1/2.7-inch CCD (Total Pixels: 1.31 million, Effective Pixels: 1.25 million)

Lens ............................... F3.2 to 3.5; f = 6 to 48mm (equivalent to 40 to 320mm lens for 35mm film)
Zoom ............................... Optical zoom, 8X; Digital zoom: 32X (in combination with optical zoom)
Image size is 640 x 480 pixels when digital zoom is used.

Focusing ......................... Contrast-detect Auto Focus (with focus lock), Manual Focus Mode, Macro Mode, Infinity Mode

Focus Range
* Distance from filter frame.
  Normal:
  Wide-angle (maximum) ........ Approximately 0.4m to ∞
  Telephoto (maximum) .......... Approximately 1m to ∞
  Macro:
  Auto focus ..................... Approximately 1cm to 50cm
  (Zoom: x1 to x1.6)
  Manual focus .................. Approximately 10cm to ∞

Exposure Control
Light Metering: ............... Multi-pattern, center point, spot by CCD
Exposure Compensation: ......... –2EV to +2EV (1/4EV units)

Shutter .......................... CCD electronic shutter; mechanical shutter, Auto (Bulb, 64 to 1/2000 second)

Aperture .......................... F3.2, F4.8, F8, auto switching or manual switching
**SPECIFICATIONS**

**White Balance** ................. Automatic, fixed (4 modes), manual switching

**Self-timer** ....................... 10 seconds, 2 seconds

**Built-in Flash**
Flash Modes: ...................... AUTO, ON, OFF, Red eye reduction
Flash Range: ...................... Normal: Approximately 0.5 to 2.5 meters
                                 Macro: Approximately 0.1 to 0.5 meters

**Recording Functions** ........ One-shot, self-timer, movie, panorama,
timer, continuous, macro, landscape,
night scene, portrait

**Monitor** ............................ 2.5" TFT, low-glare color HAST LCD (122,100 pixels, 555 x 220)

**Viewfinder** ...................... LCD Monitor

**Clock** .............................. Built-in quartz digital timepiece for time and date recording and storage with image data; auto calendar up to 2049

**Input/Output Terminals** ..... DIGITAL IN/OUT, USB port (special mini port), AC adaptor connector, VIDEO OUT (NTSC, PAL)

**Power Supply** .................... Four AA-size alkaline or lithium batteries
                                 Four AA-size nickel-hydrogen rechargeable batteries (NP-H3)
                                 AC adaptor (AD-C620)

**Battery Life**
The values noted below indicate the number of hours before battery failure under normal operating temperature (25°C). These values are for reference only, and do not guarantee that any particular set of batteries actually will provide the service life indicated. Low temperatures shorten battery life.

<table>
<thead>
<tr>
<th>Type of Operation</th>
<th>AA-size Alkaline Batteries LR6</th>
<th>AA-size Lithium Batteries FR6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Continuous Playback</td>
<td>Approximately 110 minutes</td>
<td>Approximately 280 minutes</td>
</tr>
<tr>
<td>Continuous Recording</td>
<td>Approximately 400 shots</td>
<td>Approximately 1020 shots</td>
</tr>
</tbody>
</table>

- The above guidelines are based on the following battery types:
  - Alkaline: MX1500 (AA) DURACELL ULTRA
  - Lithium: Energizer
- Battery life varies with brand
- Figures are based on continuous recording under the following conditions:
  - Flash turned off
  - One zoom slider switching between T (Telephoto) and W (Wide-angle)
- Regardless of use of the camera’s flash, zoom function, turning on and off the POWER Switch, as well as other operating conditions may affect the above values.

**Power Consumption** ........... Approximately 6.2W

**Dimensions** .................... 142.5(W) x 77.5(H) x 71(D) mm
                                 (Excluding projections, lens up.)

**Weight** ......................... Approximately 330g
                                 (excluding batteries)
Standard Accessories ...... 8MB COMPACTFLASH memory card; 2-way shoulder/wrist strap; soft case; lens cap; USB cable; video cable; data transfer cable; CD-ROM; four LR6 alkaline batteries; wired remote controller; wired remote controller battery (CR2025 x 1); Basic Reference, Bundled Software user’s Manual

• This camera does not have a separate battery to power its clock. Clock settings are cleared whenever power to the camera is cut off (by batteries going dead while the camera is not connected to an AC power outlet with the AC adaptor) for about 24 hours. After power is resumed, either by loading fresh batteries or connecting to an AC power outlet, you will have to set the correct time and date again.
• The liquid crystal panel built into this camera is the product of precision engineering, with an effective pixel rate of 99.99%. This also means, however, that 0.01% of the pixels can be expected to fail to light or to remain lit at all times.